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Getting Started Overview

This article provides an overview for getting started with your SQL Sentry Installation. Here we will list 
several helpful links to our documentation, blogs, and important SolarWinds account links to help 
guide you through the process. For information about SQL Sentry Pricing, or to download a free trial, 
visit SQL Sentry | SolarWinds.

Additional Information:  See the following helpful links:

SQL Sentry Blogs

SolarWinds Customer Portal

Submitting a SolarWinds Support ticket

SQL Sentry Architecture
A basic SQL Sentry installation consists of three components:

Getting Started Overview
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SQL Sentry 
Component Description

SQL Sentry Client The SQL Sentry Client displays the historical and real-time data for your 
monitored targets that is collected by the SQL Sentry Database.

SentryOne 
Monitoring 
Service

The SentryOne Monitoring Service remotely collects data from the target servers 
and writes that data to the SQL Sentry Database.

SQL Sentry 
Database

The SQL Sentry Database collects and retains performance data for your 
monitored targets.

Additional Information:  For more information about SQL Sentry components and architecture, 
see the SQL Sentry Components and Architecture article.

Account Requirements
The account used for running the SentryOne Monitoring Service should be a domain account and 
needs to have local Windows Admin and Sys Admin rights on all the target server(s) that you want to 
monitor. 

Additional Information:  For more information about security options in SQL Sentry, see the SQL 
Sentry Security Overview, SQL Sentry Monitoring Service Security, and SQL Sentry Portal 
Security articles.

SQL Sentry requires several ports open to collect data from target servers. 

Additional Information:  For more information about the ports required to collect information in 
SQL Sentry, see the SQL Sentry Performance Analysis Required Ports article.

SQL Sentry Client users need allow_all permissions to the SQL Sentry Database for full access to the 
information collected by the SentryOne Monitoring Service. Visibility and functionality for individual 
users can be restricted through Rights-based or Role-based security in the SQL Sentry Client.

Additional Information:  For more information about the present security options in SQL Sentry, 
see the SQL Sentry Rights Based Security, and SQL Sentry Role Based Security articles.
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System Requirements and Installation
Before installing SQL Sentry, check the System Requirements to ensure your system meets the 
minimum standards to run SQL Sentry. SolarWinds recommends that a dedicated VM should host the 
SQL Sentry components and that no SQL Sentry components be installed directly on production 
servers. If a dedicated VM hosting the SQL Sentry components isn't possible, a testing or 
development server that does not have a heavy workload could work for an evaluation or proof of 
concept. 

Important:  Clients can be installed anywhere, as long as they can communicate with the SQL 
Sentry Database to pull data. It's not recommended to connect to the SQL Sentry database with 
the SQL Sentry client through a VPN because doing so can affect the SQL Sentry Client's 
performance. 

For more information about recommended system spec information for your SQL Sentry installation, 
see the SQL Sentry Installation Recommendations article.

After you have checked the system requirements, you install SQL Sentry, complete the onboarding 
process, and apply your license. 

Additional Information:  If you are installing multiple clients and monitoring services across 
many targets, consider installing your SQL Sentry Installation with the Enhanced Platform 
Installer.

Important:  If you plan to monitor targets in other domains with various levels of trust or have 
targets in datacenters that span large geographical distances, modifications to the 
implementation may be required. 

Our two options for cross-domain monitoring are Site Configuration and Pass-Through 
Authentication. SolarWinds always recommends Site Configuration because Pass-Through 
Authentication behavior can be inconsistent.

Additional Information:  For information about site configuration or watching targets across 
domains, see the SQL Sentry Site Configuration and SQL Sentry Watching Targets Across 
Domains articles.

System Requirements and Installation
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SQL Sentry Portal
SQL Sentry Portal is a browser-based option for accessing your SQL Sentry environment data that 
uses your existing SQL Sentry database.

For information about Getting started with SQL Sentry Portal, see the Getting Started with SQL 
Sentry Portal article.
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SQL Sentry Onboarding

Launching the SQL Sentry Client
Additional Information:  If you are using the SQL Sentry Virtual Machine on Azure, see this 
onboarding video.

When you launch the SQL Sentry client for the first time, you interact with the Onboarding wizard. The 
Onboarding wizard helps you understand and configure features in SQL Sentry. Once the onboarding 
process is complete, add your first monitored target, and jump right in to tuning your environment! 
During onboarding, you're introduced to:

 l Applying your license 
 l Setting up a user for alerting purposes
 l Enabling your email alerts

Note:  During the onboarding process you can skip steps that may not be applicable to you, and 
you can always change any options at a later time with the SQL Sentry client.

Onboarding Wizard:  Initial Screen
Launch the SQL Sentry client.

Select Continue.

SQL Sentry Onboarding
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Note:  If you have other SQL Sentry connections from previous installations, opening the SQL 
Sentry client will display the SQL Sentry Database Connection Management screen. If this 
happens, select Connect for the connection you want to onboard.

Onboarding Wizard:  License Configuration
On the License Configuration screen you have three options:

 1. Continue with trial - Select this option if you do not have a license and you are just getting 
started with a SQL Sentry trial evaluation. You typically have 30 days from your installation to 
evaluate the SQL Sentry software. See the product trial website for more information or contact 
sales@solarwinds.com for more information.

 2. Activate a license online - Select this option if you are an existing SQL Sentry customer and 
have your license available to copy/paste into the Onboarding wizard.

 3. Activate a license offline- Select this option if you are an existing SQL Sentry customer and 
need to activate your license offline by using the SolarWinds Customer Portal to generate a key.
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Option 1. Continue with trial

If you downloaded the trial from the SolarWinds website, there are no additional screens, and you'll 
continue directly to the Tell Us More About Yourself screen.

If you obtained your trial from an AWS or Azure Marketplace image, you will get a Trial Information 
screen. Complete all enabled fields on the Trial Information screen, then select Continue with trial. 
The next screen will be the Tell Us More About Yourself screen.

Launching the SQL Sentry Client
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Option 2. Activate a license online

Paste your license from the SolarWinds Customer Portal into the License Key field and complete the 
form with your Name, Email, and Phone information. Select Activate to continue.
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Option 3. Activate a license offline

Copy the value from the Unique ID field to generate a license key file in the SolarWinds Customer 
Portal. Save the file, use Browse to load it, then select Activate to continue. 

Additional Information:  See the How to manually register a SolarWinds license article for more 
details on generating the key from the customer portal.

Onboarding Wizard:  Tell Us More About Yourself
Enter your user information, then select Save.

Launching the SQL Sentry Client
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Onboarding Wizard:  Enabling Email Alerts
During the onboarding process, you have the ability to enable email alerts. On the first screen, you'll be 
asked if you would like to Enable Email Alerts. You can configure this now or later. See the SMTP 
Settings article for more information on doing this later or making changes.
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Configure my own SMTP Server now

If you choose to Configure my own SMTP Server now, you'll see the second Enable Email Alerts 
screen shown below:

Launching the SQL Sentry Client
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 1. Enter the domain name or IP address of the SMTP server that you want to be used for routing 
SQL Sentry email notifications in the SMTP Server address field.  

Note:  If using localhost, keep in mind this will be the local SMTP server on the machine 
where the SQL Sentry monitoring service is installed, since it's responsible for sending all 
notifications. The SQL Sentry client doesn't send any notifications.

 2. Enter the Email from Address. This is the address that appears on the from line of all email 
notifications sent by SQL Sentry. 

 3. Enter a Custom port number if needed.

 4. Enter Security credentials if needed.

 5. Select Test to generate a test email for a specific address. 

 6. Select Save to save your information.

Note:  

 l The Security (Optional) section is not required in most environments. If your environment 
requires this authentication for your SMTP server, specify a User Name and Password.

 l Note:  You may need to contact your network administrator first to ensure that the IP 
address of the monitoring service computer has been granted both connect and relay 
permissions for the specified SMTP server.

Important:  For the most accurate SMTP test, use the client installed on the SQL Sentry 
monitoring service computer to send the test message. If you use a client on a different 
computer, such as your local workstation, the results may be different. For example, your SMTP 
server may allow relay from your workstation but not from the SQL Sentry monitoring service 
computer, in which case the test from your workstation would succeed, but the SQL Sentry 
monitoring service would be unable to deliver notifications.

Onboarding Wizard:  Let's Go!
Select Let's Go! to launch the client.
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Success:  You've configured SQL Sentry for your environment! Once the onboarding process is 
complete, you'll want to add your first monitored target as described below.

Adding Targets and Instances to Watch
On the Add Target screen, select the type of target from the target type drop-down box. Enter the 
name of the target you'd like to monitor in the box below.

Adding Targets and Instances to Watch
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Important:  For Azure SQL Database and Azure SQL Data Warehouse, provide the database or 
data warehouse name in addition to the Target name (which is the full URL to the endpoint). 
Both Azure features require credentials to be provided. These credentials are the SQL logins 
defined for the database server or data warehouse; they are not Azure account credentials. In 
addition, the firewall rules must allow access to the monitoring service, either directly over the 
internet; or through a configured VNet. Azure SQL Database and Azure SQL Data Warehouse 
only support access through port 1433.

Important:  For FCI cluster nodes, provide the client access name in the please enter the name 
of the target field. For SQL Sentry Versions 2021.12 and newer, when watching a new FCI 
instance, you will be prompted to add and watch all possible owners of the instance. Select 
Yes to add and watch all possible owners of the FCI. For more information about the Enhanced 
FCI feature with SQL Sentry, see Enhanced FCI.

Important:  For AG Availability Group Clusters, add the individual servers that are a part of the 
Availability Group. It's highly recommended to monitor all Availability Group replicas for optimal 
Availability Group specific alerts and functionality. Monitoring all Availability Group replicas 
isn't required, but will result in the loss of Availability Group alerts and functionality.  
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Select Connect to test the target for feature availability. If the connection is successful, the categories 
listed show green lights next to them.

 Otherwise, if there's limited access, you may be unable to collect data for some or all of the given 
categories:

 l Disk Activity
 l Disk Space
 l Performance Counters
 l Windows Dashboard
 l Windows Processes

It's recommended that you try to fix these limited access issues, though in some cases limited access 
is your only option (such as using a cloud-hosted SQL Server instance). Because you won't have 
access to the operating system, this would fall under Limited Access. After reviewing the feature 
availability chart, run this check again with Retry, or select Next to continue. 

Once the initialization process has completed, select Open to monitor the target. You may see the 
Start Page populate with information about your target as soon as the initialization completes.

Adding Targets and Instances to Watch
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Note:  If errors occur while adding targets or instances, it may be due to problems with security, 
network connectivity, and/or name resolution. For more information, see the Security and the 
SQL Sentry Server topic.

If you configured a SQL Sentry Portal connection during installation, the Watch Status window will 
have a Portal button. Click Portal to open the SQL Sentry Portal Access Information window which 
includes a clickable link to your SQL Sentry Portal connection. 

For more information about configuration options, see the Getting Started Cheat Sheet.

Success:  Congratulations, you have successfully installed SQL Sentry, configured global notification 
settings, and you are now ready to start using the SQL Sentry client for managing events across your 
enterprise.
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Maintenance
Just as with any other SQL Server database, it is important that regular maintenance activities be 
performed on the SQL Sentry database to ensure optimal performance. For more information, see the 
SQL Sentry Database Maintenance topic.

Maintenance
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Monitoring Additional Targets

Terminology
When the word target is used, we are referring to the device that houses your data, whether it's a 
physical server, cloud installation, APS appliance, or AWS RDS for SQL Server. Instance is referring to 
an instance of SQL Server or SSAS.

Supported Targets and Instances
Currently, SQL Sentry supports the monitoring of Windows, Azure SQL Database, SQL DW, APS 
appliance targets, AWS RDS for SQL Server targets, and Managed Instances. For more information 
about Managed Instances, see the Reaching for the cloud with SQL Sentry & Managed Instance 
article. Supported instances include SQL Server and SSAS. For more information about instances, 
including supported versions, see the System Requirements topic.

Access Level
When adding a new target, the first step is completing a feature availability test. The results of this 
test determine whether the target is added with full access or limited access. When a target is added 
with full access, the monitoring service collects Windows level metrics and provides you with full 
access to the features of performance analysis.

If the target fails the feature availability test, select the troubleshooting link, and attempt to resolve 
the issue. After applying a solution, retest the target. There are some situations in which limited 
access is the only option. For example, if you are monitoring a cloud-based SQL Server instance, you 
likely don't have access to the OS. When limited access is applied, the monitoring service doesn't 
collect performance counters, and access to the Windows Dashboard, Disk Activity tab, Disk Space 
tab, and Windows Processes tab are restricted. For more information about adding a Windows target, 
see the Performance Analysis for Windows topic.
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Adding Instances 
Add additional monitored instances to your SQL Sentry environment. Right-click either the shared 
groups node, a site node, a target group node, or an existing target node in the Navigator pane, and 
then select Add, or select File to add an instance. 

Adding Instances
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In the Add dialog box, choose the desired instance type from the drop-down menu, and then select 
Connect.
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Note:  

 l When adding a new target, SQL Sentry attempts to resolve the name/IP address of the 
target being added. There are no scans of IP ranges or subnets.

 l See the Watched Target Objects article for information about objects added to the target.

Important:  When adding FCI cluster nodes, provide the client access name in the please enter 
the name of the target field. For SQL Sentry Versions 2021.12 and newer, when watching a 
new FCI instance, you will be prompted to add and watch all possible owners of the instance. 
Select Yes to add and watch all possible owners of the FCI. For more information about the 
Enhanced FCI feature with SQL Sentry, see Enhanced FCI.

Important:  When adding AG Availability Group Clusters, add the individual servers that are a 
part of the Availability Group. It's highly recommended to monitor all Availability Group replicas 
for optimal Availability Group specific alerts and functionality. Monitoring all Availability Group 
replicas isn't required, but will result in the loss of Availability Group alerts and functionality.  

Important:  When adding an Azure SQL Server Managed Instance, select SQL Server from the 
type of target drop-down menu. 

Adding Instances
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Watching Instances 
When you add a new instance to your environment it's monitored by default unless you explicitly 
decide not to watch the new instance. SQL Sentry monitors instances or objects with a status of 
Watched. Instances or objects that are not being watched are displayed with a grayed-out icon next to 
their name in the Navigator pane.

Unwatched instances or objects can have their status set to Watched through their respective context 
menus by selecting Watch. Once you watched a new instance, the SQL Sentry monitoring service 
starts actively monitoring the instance and its objects and begins honoring any associated configured 
conditions and actions.
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Note:  Immediately after adding an instance or setting an instance to a watched status, SQL 
Sentry begins to synchronize with that instance. Exactly how long the synchronization process 
takes depends on the number of objects associated with the instance, the amount of historical 
data available, and how many instances are being watched at the same time. The watched 
status window keeps you informed of the process and alerts you to any errors.

Modifying Instance Properties
After you’ve added an instance, you may need to change how SQL Sentry connects to the target. You’ll 
see two options for connection properties when right-clicking on an instance: 

Property Description

User 
Connection 
Properties

Defines how your SQL Sentry client connects to a monitored server for the current 
user. These properties can vary for each client in your environment. The SQL Sentry 
client only connects directly to a monitored server under specific scenarios. For more 
information about the scenarios and specific security requirements, see the Client 
Security topic.

Monitoring 
Service 
Connection 
Properties

Defines how the SQL Sentry monitoring service connects to the selected server. The 
setting can be applied from any SQL Sentry client. Right-click on the instance, and 
then select Monitoring Service Connection Properties to configure the monitoring 
service connection. For more information, see the Monitoring Service Security topic.

Modifying Instance Properties
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Within the connection properties window, there are several properties that can be changed:
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Property Description

Enable 
Integrated 
Authentication

Tells what instance to use for the integrated Windows account information.

Credentials Where you enter SQL Server credentials if you're not using integrated 
authentication.

Alias By default, you'll see the server name that you initially entered when adding the 
instance.

Port Used to connect to the SQL Server if it has been configured to a non-standard 
port.

Access Level Used to assign the level of access that SQL Sentry has to the selected target. A 
target with limited access is not able to access Windows-based features, such as 
the Windows Dashboard, Windows Processes tab, Disk Space tab, or Disk Activity 
tab. Limited Access targets also don't have access to PerfLib performance 
counters for that target.

Modifying Instance Properties
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Note:  All of these settings are available for SQL Server instances. SSAS instances only offer 
the Port setting. Targets offer the Access Levelsetting.

If you're monitoring the instance with Performance Analysis, changing the Monitoring Service 
Connection Properties to SQL Server credentials isn't supported. For more information, see the 
Performance Analysis Security Requirements topic. 
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Getting Started with SQL Sentry Performance 
Analysis

Performance Analysis Features
Performance Analysis allows you to gather and display detailed information about your monitored 
servers within your environment. Performance analysis provides ease of access through a variety of 
tabs.

Note:  Available tabs and features vary by target type (e.g. SQL Server, SSAS, Windows, etc.).

Dashboard
The Dashboard provides a graphical representation of the monitored server activity through a variety 
of graphs. Color coded graphs distinguish between what's used by the instance versus any other 
processes.

Getting Started with SQL Sentry Performance Analysis
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Note:  The information shown on each tab is relevant to the time shown on the toolbar. See 
how the server looked at a given date or time by selecting the desired time in the Start and 
End drop-down boxes. Select Sync to synchronize all the tabs within the same time frame.

The left side displays Windows metrics for the monitored server.

The right side displays SQL server metrics for the monitored instance.
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Note:  If you are running in Limited access mode, you can only view the instance level metrics.       

Additional Information:  For more information about the Performance Analysis Dashboard, see 
the Dashboard article.

Processes
The Processes tab presents a list of processes that are running on your monitored server. Metrics 
related to the resource utilization of these processes is also shown. 

Performance Analysis Features
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Disk Activity
The Disk Activity tab displays information about the data and log files on your server. This tab 
displays the latency for reads and writes from files on your disk, and the latency from the system to 
the disk controllers. 

Additional Information:  For more information about the Disk Activity tab, see the Disk Activity 
article.

Disk Space
The Disk Space tab displays information about the size of the files on your disks, and the free space 
on your disks. Additionally, this tab provides detailed information about Data and Log files (auto 
growth settings, number of VLFs, etc).    
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Additional Information:  For more information about the Disk Space tab, see the Disk Space 
article.

Top SQL
The Top SQL tab displays potentially problematic queries and procedures running on your monitored 
instance. Top SQL also provides a look at the execution plan diagrams and history of queries and 
procedures captured by SQL Sentry.

Additional Information:  For more information about the Top SQL tab, see the Top SQL article.

Performance Analysis Features
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Indexes
The Indexes tab provides a view of the collected table and index information according to the settings 
and schedules chosen when enabling the fragmentation manager solution.

Additional Information:  For more information about the Indexes tab, see the Indexes article.

AlwaysOn
The AlwaysOn tab displays information about configured availability groups.

Additional Information:  For more information about the AlwaysOn tab, see the AlwaysOn 
article.
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Blocking SQL
Blocking SQL displays a view of the blocking events that were collected on your server.

Note:  Blocking SQL provides different versions of the block depending on which SPIDs were 
being blocked, and which SPID was the head blocker at the time.

Additional Information:  For more information about the Blocking SQL tab, see the Blocking SQL 
article.

Query Plans
The Query Plans tab lists all plans collected for Top SQL events for the specified date range. This 
provides a detailed chronology of all query plan changes, so you can go back to any point in time to 
see when a plan change may have led to a query performance problem.

Additional Information:  For more information about the Query Plans tab, see the Query Plans 
article.

Deadlocks
Deadlocks displays a grid of the SPIDs that owned a lock on a resource, as well as SPIDs waiting for a 
resource. This is a graphical representation, that allows you to easily identify the steps leading to the 
deadlock.

Performance Analysis Features
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Additional Information:  For more information about the Deadlocks tab, see the Deadlocks 
article.

Quick Traces
QuickTrace is SQL Sentry's version of profiler, but without the overhead. You can specify how long 
QuickTrace runs, and whether it collects statement events. Additionally, QuickTrace can be made as 
a response to an event.

Additional Information:  For more information about the QuickTrace tab, see the QuickTrace 
article.
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Getting Started with SQL Sentry Event Calendar

Introduction

Video Overview

Opening Event Calendar
When opening a target from the SQL Sentry navigator, you'll be asked to select Event Calendar or 
Performance Analysis.

Note:  As mentioned in the View Selector message, if you want to always go to the Event 
Calendar or Performance Analysis by default, you can change this in User Preferences to 
bypass the popup.

Getting Started with SQL Sentry Event Calendar
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Deselect the Prompt me to select a product when left-clicking to open a node option, then select 
Calendar View or Performance Analysis as your default.

For the Default Event View Style, you can choose Calendar View, List View, or Split View. These views 
are introduced below and explained in more detail in the Calendar & List Views article.

Event Views

Calendar
The calendar view provides a visual way to understand what is happening on the target and when. 
The default view shows you the current time. You can look back to troubleshoot a performance issue 
or jump forward to view scheduled jobs. Looking forward is helpful to discover a hot spot of 
upcoming activity that might lead to blocking or other performance issues.
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Note:  The default calendar view can be busy on some targets, so remember that you can zoom 
into a shorter period of time. The view above shows a one hour view instead of the one day 
default. Zooming and other navigation options are shown in the Calendar & List Views article. 

List
The list view (use the View drop-down in the top navigation bar to access) provides an expandable list 
of events for the selected time period. This can be a great way to view large jobs that have multiple 
steps. This puts them into an organized list that you can expand for more details.

Event Views
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Note:  All the columns and fields at the top of the list view have built in filter features. Hover 
over Event Source Name, Object Name, Start Time, End Time, Duration, Run Status, or 
Message Text to see the available filter options by selecting the  filter icon that appears. 

For example, use a Run Status filter to view only events that are In Progress, or use the Custom Filter 
option to build a more complex filter condition on any of these items.

Split
The split view option divides the event view between calendar and list views.
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Additional Views and Filters
In addition to a single day, the views can show multiple days at the same time, filtered views, or a 
combination of views.

Multi-day view
In the split view example below, the Days option is set to 3 and the view is displaying today (Tue, 
3/16/2021) as well as yesterday (Mon, 3/15/2021) and tomorrow (Wed, 3/17/2021). 

Filtered view
The Navigator pane has an Event Calendar tab that allows you to create filters for the event views. 
The filter has multiple tabs and options for statuses, event text, event sources, and more. In the 
example below, a multi-day view has a filter on the Event Sources tab applied to show only Windows 
Task Scheduler Tasks. 

Set your filters, then select the Apply Filter button to apply it to the view.

Additional Views and Filters
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Tips and Tricks
Additional Information:  See SQL Sentry Event Calendar Tips and Tricks to dive into more ways 
to make the event calendar views work efficiently for you and make correlations between 
events and issues on your monitored targets.
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Introducing Conditions, Actions, and Settings

The Onboarding Wizard
During the onboarding setup wizard, several global settings are configured for your installation. If you 
enter your SMTP settings and add a user, default conditions and actions are added to help you get 
started. 

Alerting and Response System Concepts
Concept Definition

Conditions Conditions are the scenarios that are being evaluated. For example, is the % 
Processor Time on the monitored target greater than 90%?

Actions Actions are what happen in response to a condition being met. For example, the % 
Processor Time was greater than 90%, so an email is sent to those configured on the 
email action. There are many actions available including executing SQL or PowerShell 
in response to a condition. See the full list of possibilities in the Actions article.

Settings Defines criteria for when a condition is met. Certain settings known as source 
settings are used to define what events are collected by SQL Sentry.

Settings
There are a couple ways to see how settings and conditions or actions are configured for your SQL 
Sentry installation.

 1. Select Reports to run the active settings list and configured actions list reports. 

 2. Select Reports > General, or view configured actions and settings directly in the 
Conditions pane (or Settings pane). 

Introducing Conditions, Actions, and Settings

page 46Getting Started Guide: SQL Sentry

sqlsentry-actions.htm


Note:  The Conditions pane displays on the right side of the SQL Sentry client by default. If you 
do not see the Conditions and Settings pane, select View > Conditions to restore it.

Hierarchy
There are several levels within the SQL Sentry hierarchy where you can configure applicable actions 
and settings:  Shared Groups Sites > Target Groups > Target > Instance > Object.

Refining actions in the hierarchy
To configure global actions or settings, confirm that the Shared Groups node is selected in the 
Navigator pane. The Shared Groups node is the global or root node of your SQL Sentry installation. 

Important:  The SQL Sentry alerting and response system uses the principle of inheritance, so 
any action or setting you configure at the Shared Groups node is passed down to all applicable 
objects beneath it. For example, if you configure a Send Email action for the SQL Server Agent 
Job: Failure condition (Shared Groups), you'll receive an email anytime a SQL Server Agent 
Job fails across your entire monitored enterprise.
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Refine actions or settings at each level, as needed. For example, if you have a development server in 
your environment that you don't want to be alerted about, disable the Send Email action at the 
instance level. This configuration only applies to that instance, and it doesn't affect any other server in 
your environment. This level of control gives you the ability to determine what happens in response to 
events occurring on your monitored targets. 

Additional Information:  For a more in-depth look at the SQL Sentry hierarchy and other alerting 
related features, see the Alerting and Response System topic.

Hierarchy
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Building SQL Sentry Advisory Conditions

Introduction

Advisory conditions in SQL Sentry enable you to check for many types of scenarios and apply an 
action to respond or alert you to the existence of the condition. The SQL Sentry installation includes 
dozens of default conditions in the advisory conditions pack that you can immediately apply actions 
to. 

On GitHub, you'll find even more advisory conditions that have been created by members of the SQL 
Sentry community (e.g. employees, partners, and customers). The conditions from GitHub must be 
downloaded and imported into your SQL Sentry environment and may require some additional 
configuration for your exact needs.

After exploring all the existing advisory conditions available, you may find that you want to create your 
own condition (or modify an existing one). This article walks through some examples to help you get 
started with building advisory conditions. See the conditions section of the SQL Sentry documentation 
for a complete guide to all options available.

Tutorial:  Creating a Condition
This tutorial walks through creating a condition by showing the steps to create an existing condition 
(High CPU). This condition uses a Windows performance counter to check for CPU that is greater 
than 90%.

Additional Information:  See the comprehensive Advisory Conditions article for details about 
the field definitions, features, and options not used or explained in this tutorial.

Step 1:  Select the Condition Type
There are several types of advisory conditions that you can create (e.g. Amazon RDS Instance, 
Analysis Services, APS, Azure SQL Database, Azure Synapse Analytics, SentryOne, SQL Server, Tintri, 
VMware Host, and Windows).

Getting Started Guide: SQL Sentry page 49

Building SQL Sentry Advisory Conditions

advisory-conditions-pack.htm
conditions.htm
advisory-conditions.htm


 1. Select the Conditions List from the Navigator pane. Note:  The conditions list is available at 
different levels in the hierarchy of targets. See the hierarchy section in the Introducing 
Conditions, Actions, and Settings article.

 2. Open the Conditions List (this example used the global one).

 3. Select the Create Advisory Condition button to get a list of condition type options.

 4. Select the condition type from the drop-down (this example uses Windows).

Tutorial:  Creating a Condition
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Step 2:  Set the Condition Options

 1. Enter a Name for your condition. (This appears in emails, logs, calendar views, etc. when the 
condition evaluates to true.)

This example uses "High CPU Example".

 2. Enter a meaningful Description for your condition. (Rich text word processing options are 
available on the toolbar above.)

This example uses "This is for finding high CPU". 

Note:  You may want to be more descriptive, use exact values, and provide helpful links in 
a condition that you create for how someone should respond to the condition.

 3. Set the Default Evaluation Frequency. (How often this condition check executes. Consider the 
performance implications of the condition check and how soon someone would need to be 
notified should this situation occur. It's not uncommon to have conditions that run only hourly, 
daily, or weekly.)

This example uses the default value of 30 Seconds.

 4. Set a Trigger Threshold. (How long does this condition need to take place to evaluate to true?)

This example uses 1 Minute.

See this blog post on the trigger threshold to learn more.

 5. Select the Severity associated with this condition. (How concerning is this condition if it occurs?)

This example uses Low.

 6. Set the Evaluation Timeout. (How long can this condition run this check before failing due to 
timeout?)

This example uses the default value of 5 Seconds.
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 7. Set the Maximum Instance Count if it needs to be more than the default value of one. (If this 
condition can return multiple results, how many should be returned?)

This example uses the default value of 1.

See this blog post on maximum instance count to learn more as it requires a specific 
combination of settings to use.

 8. Select a Color to highlight this condition. (Which color should be used to highlight this condition 
in the application?)

This example uses #FFFF00FF.

 9. Choose where to Highlight on Dashboard Chart. (Where should this condition be highlighted on 
the Performance Analysis Dashboard, using the selected Color?)

This example uses Windows: CPU Usage.

See the Send to Alerting Channels section of the Actions article for an example of how this 
appears when a condition evaluates to true.

 10. Constrain the condition to Supported Versions if needed. (Control which environments this 
condition checks against. Is there a minimum or maximum version of Windows where this 
counter is available, or is this situation only a problem in certain versions? This uses the numerical 
release number of the product, i.e. Windows Server 2019 is NT 10.0, so 10.0 would be used in 
these fields. Leave one or both of the fields blank if this isn't applicable.)

Step 3:  Define the Condition
Below the area where the options are set, there's the word And followed by the Add New Condition 
icon (plus sign in a circle) and the Add New Condition Group icon (a Venn diagram symbol). This is 
where you define the scenario for your condition. The High CPU condition is a one-step condition, so 
we'll ignore the And and Add New Condition Group features for now (see more about those in the 
Conditions with multiple steps section below).

 1. Select the Add New Condition icon.

 2. Select Add Numeric Comparison from the Add New Condition dropdown menu.

Tutorial:  Creating a Condition
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 3. Select the Type box, then choose Performance Counter from the dropdown menu.

 4. Select the Category box, then choose Processor Information from the dropdown menu. Note:  
The Performance Counter is set to Windows performance counters because the advisory 
condition type was set to Windows in the first step.
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 5. Select the Counter box, then choose % Processor Time from the dropdown list.

 6. Select the Instance Type box, then choose Total from the dropdown list.

Tutorial:  Creating a Condition
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 7. Select the word Equals, then choose Is greater than from the dropdown list.

 8. Select the Type box, then choose Explicit Value from the dropdown list.

 9. Enter 90 in the Explicit Value box, then select the save button.
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Your condition has been saved.

Success:  You have created a new advisory condition!

Note:  The Add Actions popup appears after saving the condition.

Select Yes if you would like to apply an action to this condition. This opens the Actions Selector 
window. See the Configuring Actions article for instructions on adding and configuring actions.

Additional Examples and Resources

Examples
As you can see from the various menus and options available in the tutorial, there are several different 
types of advisory conditions that you can create, and a staggering number of combinations that can 
be created. You can compare performance counter values to the result of a SQL Server query, a 
current value to the last value, match string values using Regex, perform calculations on the values, 
and so on. Use the existing conditions installed with SQL Sentry and available on GitHub as a source 
of inspiration for building your own conditions.

Additional Examples and Resources
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Clone conditions

 1. Right click on a condition in the Conditions List.

 2. Select Clone from the context menu. A small window will pop up and ask you to name your copy 
of the condition.

 3. Enter the Name of your condition, then select OK.

Success:  You have cloned an existing condition and can now use it as a template for a new condition. 
Make edits as needed and save it.

Conditions with multiple steps

The tutorial used a single step condition to check for % Processor Time > 90. If you wanted to check 
for % Processor Time > 90 and some other condition, such as Available Memory (MB) < 500, you can 
do that in the same condition. See the Using Step Logic in SQL Sentry Advisory Conditions blog post 
for a deep dive into those possibilities.

Nested conditions

You can embed existing conditions into conditions to nest the steps and checks. For example, the 
High Ad Hoc Query Plans condition (shown below) contains multiple checks, including the Low Page 
Life Expectancy condition.

Note:  If you take a look at the High Compiles + High CPU condition, you'll see three different 
advisory conditions nested in the check in steps and condition groups. If you have a complex 
condition in mind, you can build it.

Blog Posts

 l Creating Advisory Conditions in SQL Sentry Part 1

 l Creating Advisory Conditions in SQL Sentry Part 2
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 l Create Advisory Conditions for SQL Server on Amazon RDS

 l Setting Up a MaxDOP Advisory Condition

 l Using SentryOne to Alert on SQL Server Database Object Changes

 l Monitoring Replication with SQL Sentry

Additional Examples and Resources
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Configuring Actions

Introduction

Note:  As a reminder, conditions describe the various states of any monitored objects (e.g. % 
Processor Time > 90%), andactions determine what happens when a condition is met (e.g. an 
email is sent).

Displaying conditions
The conditions displayed in the Conditions pane change depending on which node or object is 
selected in the Navigator pane. If you don't see the Conditions pane once you have selected your 
desired node in the Navigator pane, select View > Conditions.

 l Select the shared groups node to see globally applied conditions in the Conditions pane. 
 l Select any applicable object level below the shared groups node to see two specific sets of 

applied conditions in the Conditions pane.

Conditions pane sections

Section Description

Inherited The top section is the Inherited section that shows you any applied conditions that are 
being passed down to the current level.
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Section Description

Explicit The Explicit section shows you applied conditions that have been set at the current 
level. Each action that you set up in your environment has an associated behavior that 
controls how the action is carried out relative to any inherited actions. See the following 
table for more information about Action Behavior:

Action 
Behavior Description

Disable Special set of instructions that simply disallow the passed down 
(inherited) set of instructions.

Override Special set of instructions that are followed instead of the passed down 
(inherited) instructions.

Combine Set of instructions that are followed in addition to the passed down 
(inherited) instructions.

Additional Information:  For more information about the Conditions pane, see the Conditions 
pane article.

Tuning Conditions and Actions
To avoid a noisy alerting system, we recommend that you tune the conditions and actions to refine 
the amount of alerts generated to the ones that are meaningful to you.

See the following resources for guidance on alert tuning:

 l SQL Server Alert Tuning Basics with SQL Sentry
 l SQL Sentry Tips & Tricks:  Tuning Advisory Conditions
 l SQL Sentry Tips & Tricks:  Common Alert Tuning Examples
 l Alerting on a Call Schedule with SQL Sentry
 l A Million Little Things:  Remediation

Adding a New Action
Add a new Action to your desired node by completing the following steps:

Tuning Conditions and Actions
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 1. Open the Conditions pane (View > Conditions), then select the desired node in the Navigator 
pane to begin adding a new action. 

 2. Select Add to open the Action Selector window. 
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 3. Expand the applicable object and condition. Use the checkbox(es) to select which actions 
should be taken in response to the condition being met, then select OK to save your changes.

Adding a New Action
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Additional Information:  For a complete list of available actions and how to configure 
them, see the Actions article.

Changing Inherited Conditions
Change the behavior for an Inherited condition by completing the following steps
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 1. Open the Conditions pane (View> Conditions), then select the desired node in the 
Navigator pane. 

 2. Select the condition you want to change in the Inherited section of the Conditions pane, then 
select Disable, Override, or Combine.

Changing Inherited Conditions
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Note:  When an inherited condition is overridden or disabled, it appears in the Inherited 
section, but its text is grayed-out, and its status is Overridden.  
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Additional Information:  For more information about actions and conditions, see the 
Alerting and Response System topic.

Changing Inherited Conditions
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Configuring Settings
Note:  As a reminder, settings define criteria for when a condition is met. Certain settings 
known as source settings are used to define which events are collected by SQL Sentry.

Configuring Settings
To configure settings, select the desired node in the Navigator pane. 

For example, select the shared groups node to configure settings globally, or select an individual 
instance node to configure settings specific to just that instance. If you do not see the Settings pane 
once you have selected your desired node in the Navigator pane, select View > Settings to open the 
settings pane. Then, select the drop-down lists found in the Settings pane to select the desired 
settings. 

See the following examples:

To configure the Top SQL Minimum Duration Collection setting globally: 

 1. Select the shared groups node in the Navigator pane.

 2. In the Settings pane, use the top drop-down list to select SQL Server settings.
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 3. Use the second drop-down list to select Top SQL Source. You should now see the Top SQL 
Source settings that are being applied globally.

 4. Change Minimum Duration to the desired value, then select OK to save your changes.

To configure the Top SQL Minimum Duration Collection setting for an individual instance:

Configuring Settings
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 1. Select the desired instance node in the Navigator pane.

 2. In the Settings pane, use the drop-down list to select Top SQL Source. You should now see the 
Top SQL Source settings that are being applied for that instance.

 3. Change Inherit from Parent to false.
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 4. Change Minimum Duration to the desired value. It saves automatically.

Configuring Settings
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Adjusting Global Runtime Threshold Settings
By default, the global Runtime Threshold settings for SQL Server Agent Jobs are set at a Minimum 
Runtime Threshold of 10 percent and Maximum Runtime Threshold of 250 percent. This means that 
any time a job runs for less than 10 percent of its average runtime or longer than 250 percent of its 
average runtime, you'll be notified. If you find you are receiving too many notifications, these settings 
can be adjusted. See the following example:

To configure the SQL Server Agent Job Maximum Runtime Threshold percent globally:
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 1. Select the shared groups node in the Navigator Pane.

 2. In the Settings pane, use the top drop-down list to select SQL Server settings.

Adjusting Global Runtime Threshold Settings
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 3. Use the second drop-down list to select SQL Server Agent Job. You should now see the SQL 
Server Agent Job settings that are configured globally.

 4. Change Maximum and Minimum Runtime Threshold Percent to the desired values.

Using time-based thresholds
Time-based thresholds are usually less valuable at the global level, particularly the Minimum Runtime 
Threshold that doesn't have much value globally. Explicit time-based thresholds tend to be more 
applicable at the actual instance or object level for overriding the global percentage thresholds on a 
case-by-case basis.

Note:  Any time an explicit time-based threshold is specified, it overrides the percentage-based 
thresholds for that object.
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Consider a job that has a great deal of volatility in runtime such as a transaction log backup that can 
run from anywhere between 30 seconds and 30 minutes, with an average runtime of five minutes. To 
avoid unnecessary percentage-based threshold notifications for the job, set its Maximum Runtime 
Threshold to 35 minutes and Minimum Runtime Threshold to 20 seconds. Select either the job's 
node in the Navigator pane, or select an instance of the job on the calendar, then follow the previous 
steps to access and change the job's Runtime Threshold settings.

Additional Information:  For more information about settings, see the Alerting and Responses 
System topic.

Adjusting Global Runtime Threshold Settings
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General Tasks

Introduction
Once you've completed the Onboarding process, you're ready to start using SQL Sentry and configure 
your environment. Some first steps may include adding additional servers (targets) to monitor, 
organizing your targets, and using the calendar. The following is a review of some common tasks 
performed using the SQL Sentry client.

Monitoring Targets and Target Groups
See the Monitoring Additional Targets article for detailed information.

Adding a Target
Select Add in the right-click context menu of one of the following nodes to add a target:

 l All Targets
 l Site
 l Group
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Deleting a Target
Select Delete Target in the right-click context menu of any target node to delete that target.  

Note:  Before deleting a target, select Stop Watching to stop watching all of the target's 
associated instances.

Monitoring Targets and Target Groups
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Warning:  Delete Target deletes the actual registration for the target from SQL Sentry. This 
includes the deletion of all historical information for any associated instances belonging to the 
target from the SQL Sentry database. Delete Target is final and can't be undone. Only use this 
command to permanently delete information SQL Sentry has stored about the target and its 
associated instances from the SQL Sentry database.

Adding a Target Group
On any site node or existing group node, right-click and select Add, and then select Group to add a 
target group. 
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Deleting a Target Group
On any existing group node, right-click and select Delete Group to delete the selected target group. 

Note:  You need to remove all targets and sub-groups before deleting a group.

Monitoring Targets and Target Groups
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Monitoring Instances

Adding an Instance
Select Add in the right-click context menu of one of the following nodes to add an instance:

 l All Targets
 l Site
 l Target Group Target
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For more information about adding an instance, see the Monitoring Additional Targets topic.

Watching an Instance
On any instance node, select Watch to begin watching that instance. For more information about 
watching an instance, see the Monitoring Additional Targets topic.

Monitoring Instances
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Event Calendar Related

Jumping to a Particular Time in the Calendar View
On any node above the object level, right-click and select Jump To > Time to open the Select the time 
window. 
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Select the desired date and time, and then select OK to open your time selection. 

Event Calendar Related
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To persist the time setting, go to Tools > User Preferences > Navigator, and then select the 
appropriate parameters. This allows you to jump to the same time for each selected view. For more 
information about the Event Calendar, see the Calendar and List Views article. 

User and Group Tasks

Adding a User
Double-click or right-click the Users node, and then select New to open the Add a User window. 
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Input the appropriate information in the user window, and then select Save to save your changes. The 
new user displays under the Users node.

User and Group Tasks
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Editing a User
Double-click or right-click the Users node, and then select Open to open the Edit User window. 
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The user window appears populated with that user's settings. Make any changes, and then select 
Save to save the changes.

User and Group Tasks
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Deleting a User
On a user node, select the delete key or select Delete User from the context menu to permanently 
delete the user.
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Adding a Group
Double-click or right-click the Groups node, and then select New to open the Add a Group window. 

User and Group Tasks
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Input the appropriate information in the group window, and then select Save to save your changes. 
The new group displays under the Groups node.
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Editing a Group
Double-click or right-click the Groups node, and then select Open to open the group window populated 
with the group's settings. 

User and Group Tasks
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Make any changes, and then select Save to save the changes.
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Deleting a Group
On a group node, select the delete key or select Delete Group from the context menu to permanently 
delete the group.

User and Group Tasks
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For more information about users and groups, see the Contact Management topic.

Events

Adding an Event Object
On any event object node, select New > Job... to open SSMS and create a new SQL Server Agent Job.
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Deleting an Event Object
On any event objects node, select Delete Job to permanently delete the object.

Events
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Note:  Not all objects support deletion from the SQL Sentry Client (Reporting Services, etc).

Watching an Event Object
On any event objects node, select Watch Job to sets the object status to Watched and 
enable conditions and actions for the object, as well as queue chaining and performance monitoring 
features, if applicable. The instance status will also be set to Watched if it isn't already watched.
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Stop Watching an Event Object
On any event objects node, select Stop Watching Job to set the object status to Unwatched, disable 
conditions and actions for the object, as well as queue chaining and performance monitoring 
features, if applicable.

Events
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Enabling an Event Object
On the event objects node, select Enable to enable the event to run according to the schedules 
defined for it.
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Disabling an Event Object
On the event objects node, select Disable to disable the event from running according to the 
schedules defined for it.
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Viewing an Event Object's Properties
On any event objects node, select Properties to display the object's native properties window.

Note:  Not all objects support the properties interface (Reporting Services, etc).

Events
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Jobs/Tasks

Starting a Job or Task
On any job or task node, select Start Job to start the job. 

Note:  If the job has more than one step, a window appears allowing you to select the step 
where you would like the job to start.

Stopping a Job or Task
On any job or task node, select Stop Job to stop the job.
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Viewing Job History
On any event objects node, select Jump To > History, and then select the range to view to open the 
job at the selected time.

Helpful SQL Sentry Client Information
The following is a list of topics that provide detailed information about aspects of the SQL Sentry 
Client including information on client glyphs, icons, and indicators:

Topic Links

Client Alerts  l For more information detailing alerts within the SQL Sentry Client, see the Client 
Alerts article.

Event 
Calendar

 l For information detailing the glyphs within the SQL Sentry Calendar view, see 
the Calendar and List Views article.

Event 
Chains

 l For more information detailing Event Chains within the SQL Sentry Client, see 
the Event Chains article.

SQL Sentry 
Client

 l For information detailing the toolbars within the SQL Sentry Client, see the 
toolbars article. 

 l For information detailing the menus within the SQL Sentry Client, see the menus 
article.

 l For information about customizing the visuals within the SQL Sentry Client, see 
the User Preferences article.

 l For a list of hot keys accessible within the SQL Sentry Client, see the Hot Keys 
article. 

Helpful SQL Sentry Client Information

page 102Getting Started Guide: SQL Sentry

event-objects.htm
calendar-list-views.htm
event-chains.htm


Adding Notes
Notes help to facilitate communication between team members. Notes can be used for change 
tracking, resolution history, and a variety of other functions. You can set notes to be included in any 
future notifications generated for an object, and to be displayed for all calendar instances of an 
object. Both of these features are valuable for sharing escalation procedures, recovery steps, 
emergency contact information, etc., with other team members.

The notes interface can be reached through a variety of context menus in the SQL Sentry client just 
about anywhere that you can act on an event object or event instance. Access the notes interface by 
pressing CTRL + ALT + N when an applicable object is selected.

Note:  When adding a note, if any failures exist for the selected event object, you will be 
prompted to clear them.

Field                     Hotkey                     Description                     

User n/a Displays the current window's username.
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Field                     Hotkey                     Description                     

Title n/a The subject of the note that appears in the selection list.

Note n/a The body of the note that can't be blank. 

Select Existing Note 
to View

n/a Enable this setting to include the note with any notifications 
related to the object.

Show for All 
Calendar Instances

n/a Enable this setting to show the note information in the pop-up of 
every event instance of the object.

New CTRL+N Creates a new note.

Save CTRL+S Saves the current note.

Delete CTRL+D To delete a note, select the desired note from the list, and then 
select Delete. 

Close CTRL+C Closes the window.

Additional Information:  For information about adding/editing notes for events in the Calendar 
view, see the Failed Instances topic.

Adding Notes
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Environment Health Overview

Introduction

 SQL Sentry Portal: This feature is available in SQL Sentry Portal. To learn more about configuring 
your environment to use the on-premises, browser-based option with your existing SQL Sentry 
database, see the SQL Sentry Portal article.

See the Monitor Health article for an example of what this feature looks like in the SQL Sentry Portal.

The Environment Health Overview (EHO) is integrated into the dashboard of the Start Page. It 
provides an at-a-glance health status of your environment with a 100-point scale score. This scale 
score is based on the severity, number of occurrences, the age of the Advisory, General, Audit, and 
Failsafe events, and the number of servers that you're monitoring.

Note:  Starting with Version 2021.12.1, the General, Audit, and Failsafe conditions are 
configured by default and have an assigned severity that affects the score on the EHO.  The 
severity level and tags associated with General, Audit, and Failsafe conditions can't be changed, 
but can be viewed in the SQL Sentry database in dbo.ConditionType and will be visible in the 
Condition Events Log when a condition evaluates to true and is logged.

Note:  Any Advisory Condition that has a defined Severity, and a Send to Alerting Channels 
action can affect the EHO score. The scale score returns to 100-points when no Advisory 
Condition events are available. For information about configuring Advisory Conditions, see the 
Advisory Conditions topic. 

The Environment Health Overview appears automatically during the setup wizard, and allows you to 
configure the Advisory Conditions to work with your performance dashboard, Event Calendar, and the 
Environment Health Overview.  

Unsupported:  On an older version of SentryOne, select Tools > Run On-boarding Wizard (requires 
client restart). The client restarts and presents you with the necessary options to configure the 
Advisory Conditions to work with your performance dashboard, Event Calendar, and the Environment 
Health Overview.
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In the SQL Sentry client, you can change where you start in the client by going to Tools > User 
Preferences. Select Start Page from the drop-down list, and the Environment Health Overview 
appears every time you start the client. For more information about User Preferences, see the User 
Preferences topic.

Introduction
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Wedgets
Note:  Version 2021.12.1 added an Info Severity category to the EHO. The Info severity doesn't 
impact the EHO score, but can be useful when searching for certain information. For example, 
the condition may notify you that some event object properties have been modified.

When analyzing a high volume of Advisory Conditions, two types of wedgets display on the 
Environment Health Overview; the first wedget is broken out by severity and the second wedget is 
broken out by tags. Selecting either wedget filters the list of events by severity or tags.

Note:  Any active filters are displayed at the bottom of the grid. Select the  (pencil icon) to edit 
the filter, or select the    (X) to dismiss the filter.

Once you've corrected the performance issue, close the affected event by selecting the link on the 
events list in the Environment Health Overview. Add notes to the event, assign the note to someone 
else, if necessary, or close out the event.

If you have many events that need to be closed out, right-click under Duration, select Close, and then 
select All for Condition. This closes all of the current conditions in the Environment Health Overview.

Wedgets
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As you work through the affected events in the list, you can trim down the time range using the slicer. 
Select the Slicers drop-down list, and then change the desired time limit.

Events Log
On the Environment Health Overview, select the desired event link under the Condition column. The 
Events Log appears filtered by the desired condition, and the filter excludes events that are closed.
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Favorite Targets
Each SQL Sentry client has its own unique Favorites group. The Favorites group is used to define a 
view of targets and instances specific to that individual SQL Sentry client. This is useful in a large 
environment, because it allows an individual user to specify a subset of targets and instances that 
they're responsible for. Select the Show Favorite Targets icon, located directly above the Navigator 
pane, to toggle the Favorites node.

When you add a target or an instance to your Favorites group, it's added to the Default Site node of 
the All Targets node ( if it isn't already a part of your SQL Sentry environment). When you add a 
target or instance to your Favorites group that's already a part of your shared SQL Sentry 
environment, the target or instance isn't duplicated. As mentioned earlier, the Favorites group is 
unique to each SQL Sentry client and defines a view of your larger SQL Sentry environment.

Favorite Targets
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Changes you make regarding the watched status, or to any configured settings, conditions, and 
actions from the context of the Favorites group are mirrored in the All Targets node. In the same way, 
changes made to targets and instances from the context of the All Targets node are also mirrored 
back to any Favorites groups that they belong to.

Virtualization Node

Introduction
The Virtualization node houses the support for VMware and Hyper-V virtualization options.
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VMware
To add a vCenter, right-click on the VMware node in the Navigator pane, and then select Add vCenter. 

Virtualization Node
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Enter the display name and your credentials, or check the box to select Use Windows session 
authentication. Select the Site drop-down menu to choose which site will be responsible for the 
monitoring of the vCenter.
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Note:  To add a vCenter, the monitoring service must be a configured user on the vCenter imple-
mentation and must have read-only access at minimum. For more information, see the VMware 
Overview for SQL Sentry topic.

Important:  If using SSPI authentication, be sure to select a site where the monitoring service 
has at least read-only access to the vCenter.

Hyper-V
Whenever a Hyper-V guest or host is monitored with SQL Sentry, it appears under the Hyper-V node. If 
the host is monitored with SQL Sentry, all of the host's guests appear as well. If only a guest is 
watched with SQL Sentry, that guest's host displays. For more information, see the Windows & Hyper-
V Overview topic.

Virtualization Node
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Object Groups

Introduction
Object Groups are useful when you need to apply similar policies to a set of objects that don't exist 
within the same hierarchical group in your SQL Sentry environment. These objects could be dispersed 
throughout your environment in different sites, groups, or subtrees, but if they share a similar set of 
characteristics, they may be ideal candidates for a similar set of policies.
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Take for example all of the transaction log backup jobs within your environment. You may wish to 
suppress Runtime Threshold alerts generated when these jobs run by disabling the Send Email 
action. Object Groups allow you to do this without affecting any other agent jobs. In the past, this 
would involve you having to go and touch each of the transaction log backup job settings individually. 
Object Groups allow you to avoid the tedious process, saving you time because you can quickly 
locate objects by name or category, add them to a group, and apply a set of policies.

As Object Groups exist outside of the normal SQL Sentry hierarchy, a condition or setting configured 
for an Object Group is applied last after any inherited or explicitly defined condition or setting. In this 
way, Object Group conditions and settings have the final say within your environment.

Object Groups
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As mentioned earlier, typical uses include disabling Runtime Threshold alerts for all transaction log 
backup jobs and applying policies to QA servers that may exist within several sites of your 
environment. When you create an Object Group, you choose how configured conditions and settings 
are applied in the group. You can create an ObjectGroup in which configured conditions and settings 
apply strictly to the group members. Alternatively, you may create an Object Group in which 
configured conditions and settings apply to the group members and their children. For more 
information, see the following section Creating New Object Groups. 

Evaluation Order

Each Object Group you create also has an associated evaluation order. This evaluation order is 
specific to just the set of Object Groups in your environment. This is valuable when you have an 
object that belongs to multiple Object Groups with a divergent set of policies. The evaluation order 
allows you to control which group's configured conditions and settings are applied. A configured 
setting or condition from the ObjectGroup with the highest evaluation order will be applied last, and 
therefore will be the effective setting or condition. For example, if you have ten object groups, with 
orders 1 through 10, then 10 will be the highest/last applied.

Note:  With object groups, the alert is applied to the first in the list. For example, if you have a 
Top SQL: Duration Threshold Max alert and it was applied in 2 object groups; group 1 and group 
5, then the alert in group 1 will eclipse the alert in group 5, so only the Top SQL: Duration 
Threshold Max alert defined in group 1 is sent.

Settings

When you add new objects to an ObjectGroup, any setting that is applicable to that object type will be 
configurable in the Settings pane. By default, each object in an ObjectGroup still receives its base set 
of inherited settings from its parent objects in the SQL Sentry hierarchy. If you would like to override 
these settings, define a setting within the ObjectGroup itself. Change the Defined setting to True. 
After you define a setting for an ObjectGroup, that setting is reflected in any applicable objects that 
belong to that group.

Conditions

Just like settings, condition/action combinations become available as appropriate when objects are 
added to a group. With any ObjectGroup selected, you can configure conditions through 
the Conditions pane. For more information, see the following section Configuring Conditions and 
Settings for an Object Group.

Creating New Object Groups

Additional Information:  See the blog post on Creating Object Groups in SQL Sentry.
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To create a new Object Group, complete the following steps:

 1. Double-click the Object Groups node in the Navigator pane to open the Object Groups Editor 
window.

 2. Select Add in the Groups section of the Object Groups Editor window to open the Add 
Group dialog window. 

Object Groups
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Note:  The Groups section of the editor window contains any previously configured 
groups in your environment. The Group Members section of the editor window allows you 
to view individual members of any selected Object Group.

 3. Enter a name and description for the group. Also take note of the Applies To drop-down box. 
The following options are available:

Option Description

Selected group 
members and 
their children

Any conditions or settings you configure for the group also apply to the 
children of the group members. This makes the group's settings and 
conditions inheritable.

Selected group 
members only

Any conditions or setting you configure for the group only apply to the 
specific members of the group and have no effect on their children. This 
makes the group's settings and conditions noninheritable.

Note:  If you're creating an ObjectGroup to set policies for all of the QA servers in your 
environment, choose Selected group members and their children because this gives you 
access to applicable settings and conditions from the instance level down to the object 
level.

If you're creating an ObjectGroup to set policies for just a finite set of objects and do not wish to 
impact or have access to children of the object, choose Selected group members only. Given 
the transaction log backup job use case discussed earlier, it wouldn't matter which Applies To 
option you chose because the agent job object is a leaf node in the SQL Sentry hierarchy.

 4. Select OK to add your Object Group.
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Adding Object Group Members

To add new members to a group: 

 1. Select a group in the Groups section of the editor window, and then select Add in the Group 
Members section of the editor window.

 2. In the Select Group Members dialog screen, choose the object type of the group member you'd 
like to add from the tree view, and then select Search to view objects of that type in your 
monitored environment.

Object Groups
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 3. Select an object, and then select OK to add it to the group. 
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Note:  You can add multiple objects by pressing Ctrl or Shift.

Configuring Conditions and Settings for an Object Group
Once you've added your desired objects to the group, you can begin configuring the conditions and 
settings for the group. Configure conditions and settings, through the Conditions and Settings pane. 
If you don't see the Conditions and Settings pane, use the View (View > Conditions) menu to open it.

To add a condition to a group, complete the following steps:

 1.  Select Object Groups in the Navigator Pane, and select the desired Object Group. 

 2. Open the Conditions pane, and then select Add to open the Actions Selector window. 

 3. Choose your desired condition/action combinations, and then select OK. 

Object Groups
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Note:  Any conditions that are applicable to the objects within your group are available for you 
to configure. You can also configure settings for the ObjectGroup through the Settings pane. 
Any settings that are applicable to the objects in your group are available for you to configure. 
As discussed earlier, by default, each object in an ObjectGroup still receives its base set of 
inherited settings from its superior parent objects in the SQL Sentry hierarchy. If you would like 
to override these settings, you must first define a setting within the ObjectGroup. To do this you 
need to set the Defined flag to true in the Settings pane. After you define a setting for an Object 
Group, that setting is reflected in any applicable objects that belong to that group.

Additional Information:  For more information about Object Groups, see the Manipulating 
Runtime Thresholds with Object Groups blog post.

Note:  If you're ever unsure of where an object is receiving its inherited settings, you can check. 
The Active Settings List report lists this information for each setting in the Object Name 
column. Access this report from the Reports menu (Reports > General > Active Settings List).

Alternatively, you can view this information directly at the individual object level. Select the desired 
object in the Navigator pane, and then open the Settings pane. The Inherent From Parent section of 
each setting group contains the name of the superior object that is passing down that group of 
settings. In the case where the object's setting has been defined with an Object Group, it lists that 
Object Group as the parent.

Schedules and Windows

Introduction
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SQL Sentry employs extensive scheduling capabilities through its Schedules and Windows features. 
Schedules and Windows can be managed through their respective nodes found in the Navigator 
pane.

Schedules has the following application within SQL Sentry:

 l Fragmentation Manager Operations

Windows has the following applications within SQL Sentry:

 l Maintenance Windows  
 l Email and Pager Windows for Users and Groups
 l Ruleset Windows for Configured Actions

Schedules
SQL Sentry allows you to create Schedules that can be applied in the following place:

Schedules and Windows
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Scenario Description

Fragmentation 
Manager 
Operations

Enable Fragmentation Manager in your SQL Sentry environment, and then select 
a schedule to perform Fragmentation Manager Operations. This schedule is 
initially specified in the Fragmentation Manager wizard. After enabling 
Fragmentation Manger for an instance, access the applied schedule through the 
Index Defragmentation settings found in the Settings pane (View > Settings).

Note:  Index Defragmentation settings, including the applied schedule, can be 
configured at the following levels: All Targets (Global), site, target group, target, 
instance, database, table, and individual index.

Additional Information:  For more information, see the Fragmentation Manager 
topic.

Windows
SQL Sentry allows you to create Windows that can be applied in the following places:

Scenario Description

Maintenance
Windows 

Used to set a schedule for the Maintenance Window. Only Log Actions are 
triggered for Failsafe Conditions inside the Maintenance Window. Maintenance 
Window settings allow a time frame to be specified while scheduled maintenance 
activities take place on that instance.

Note:There are several options for configuring Maintenance Windows within SQL 
Sentry, including Maintenance Windows specific to targets, instances, and the SQL 
Sentry database.

Maintenance windows use the local time that is specific to the target.                         
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Scenario Description

Email and 
Pager 
Windows for 
Users and 
Groups

Email and Pager Windows can be assigned to a user or group. Windows control the 
time frame of when alerts are sent to the user or group. When you assign an 
Email or Pager Window to a user or group, you have the option to change the 
Window Behavior to one of the following:

Option Description

Perform actions 
that occur 
within the 
window

Only email and pager actions that occur during the Window's 
active time frame are carried out. Email and pager actions that 
are triggered outside of the active time frame are suppressed.

Don't Perform 
actions that 
occur within the 
window

Email and pager actions that occur during the active time 
frame are filtered or suppressed. Only email and pager actions 
that occur outside of the Window's active time frame are 
carried out.

Note:  To apply an Email or Pager Window to a user or group, double-click the user 
or group in the Navigator pane to open an Edit User/Group tab. Use the Email or 
Pager Window drop-down list to choose the desired Window. Use the Email or 
Pager Window Behavior drop-down list to choose the desired behavior.

Additional Information:  For more information, see the Contact Management topic.

Schedules and Windows
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Scenario Description

Ruleset 
Windows for 
configured 
Actions

Windows may be applied to configured actions that control the time frame of when 
that action can take place. When you assign a Window to a configured action you 
have the option to change the Window Behavior to one of the following:

Option Description

Perform actions 
that occur 
within the 
window

Only email and pager actions that occur during the Window's 
active time frame are carried out. Email and pager actions that 
are triggered outside of the active time frame are suppressed.

Don't Perform 
actions that 
occur within the 
window

Email and pager actions that occur during the active time 
frame are filtered or suppressed. Only email and pager actions 
that occur outside of the Window's active time frame are 
carried out.

Note:  To apply a Window to a configured action, select the action in the Conditions 
pane, and then open the Ruleset tab for the selected action. Use the Window drop-
down list to select your desired Window. Edit an existing window by selecting Edit, 
or create a new window by selecting New. Select Window Behavior, or use the 
Window Behavior drop-down list to choose the desired behavior.

Additional Information:  For more information, see the Alerting and Responses 
System topic.

Creating a Schedule or Window
Expand the Schedules and Windows node in the Navigator pane to display the Schedules and 
Windows nodes. Create a new Schedule or Window by completing the following steps:

 1. Double-click the Schedules or Windows node to open the Select a Schedule or Select a Window 
selection screen. 
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 2. Select New to open the Schedule Properties or Window Properties window.

Schedules and Windows
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Note:  You can also edit existing Schedules or Windows by selecting a schedule or 
window and then selecting Edit.

 3. Enter a name for your Schedule or Window, then configure the properties. Select OK to save 
your schedule or window.
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Schedule or Window Properties Options

The following Schedule or Window Properties options are available:

Schedules and Windows
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Section Description

Name The name that is applied to the Schedule or Window.

Schedule
Type

Option Description

Recurring A recurring Schedule or Window repeats according to the frequency 
and duration you choose.

OneTime A one time Schedule or Window takes place only on the occurrence 
date you specify.

Compound A compound Schedule or Window can be created that combines 
previously created schedules.

Window
Duration

Specify the duration or length of time that the Window is active.
Note:  Window Duration applies only to Windows and is not available for Schedules.
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Section Description

One-time 
occurrence

Select the time you would like the one-time occurrence of the Schedule or Window to 
take place.

Note:  This option is only applicable for schedule type: One Time.

Frequency The Frequency of the Schedule or Window can be set to either Daily, Weekly, 
or Monthly. Additional Frequency options are available depending on the chosen 
occurrence type.

Daily
Frequency

Use the Daily Frequency options to select the specific time(s) during the day the 
Schedule or Window occurs.  

Duration Use the Duration section to specify a Start Date and End Date.

Summary The Summary description auto-fills according to the chosen options. You may add to 
the summary or change the text as desired.

Contact Management

Introduction
The Contacts node is used to create and maintain Users and Groups within your SQL Sentry 
environment.Users and Groups are created for a couple of different reasons. They can be created for 
notification purposes within the SQL Sentry Alerting and Responses System. Once you configure a 
Send Email or Send Page action, any user or group that's been created becomes available for you to 
choose as a target.

The other reason for defining Users and Groups is the ability to assign rights to them. These rights 
are used to restrict the access of Users and Groups within the SQL Sentry client. For more 
information, see the SQL Sentry Client Security topic.
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Viewing Notifications by User or Group
From the Contacts node, it's possible to view all notifications assigned to a user or group. View all 
notifications assigned to a user or group on the Contacts node by completing the following steps:
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 1. Expand the Contacts node in the Navigator pane, and then expand the Users or Groups node.

 2. Select the desired user or group, and then open the Conditions pane to display any associated 
notifications. 

Contact Management
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 3. Use the list of notifications to disable or change any of the configured actions.
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Users
 1. Expand the Users node in the Navigator pane to list any configured users.

Adding a User

Add a User by completing the following steps:
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 1. Right-click the Users node, and then select New to open the Add a User tab.

 2. Enter the applicable information for your User, and then select  (Save toolbar button) to save 
the new user.
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Editing a User

Edit an existing user by completing the following steps:
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 1. Double click or right click an existing User to open the Edit User tab.

 2. Edit the applicable information for your user, and then select  (Save toolbar button) to save 
your changes.
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Note:  For detailed information about the options available in the Add a User, and Edit 
User tabs, see the User Fields section below.

Deleting or Disabling a User

To delete a user, right-click the user, and then select Delete User from the context menu. Select OK to 
confirm the deletion.
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To disable a user, right-click the user, and then select Disable User from the context menu. Disabled 
users are grayed-out in the Navigator pane and have Disabled next to their name.
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Note:  When you disable a user, they no longer receive notifications for any actions where they 
were the selected target. If the disabled user is part of a group, that user no longer receives noti-
fications when that group is notified. 

Enabling a User

To enable a user that has been disabled, right-click the user, and then select Enable User.
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User Fields

When you create a new user or edit an existing user, the following fields are available.
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Field Description

First Name The first name of the user. Required.

Last Name The last name of the user.

Email 
Address

The email address of the user. Required.

Pager 
Address

The pager address of the user.
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Field Description

Email 
Window

The Email Window for the selected user. When you assign an Email Window to a user 
or group, be sure to take note of the Email Window Behavior option.

Additional Information:  For more information about Schedules, see the Schedules 
and Windows topic.

Email 
Window 
Behavior

Option Description

Perform actions 
that occur within 
the window

Only email actions that occur during the Window's active time 
frame are carried out. Email actions that are triggered outside 
of the active time frame are suppressed.

Don't Perform 
actions that occur 
within the window

Email actions that occur during the active time frame are 
filtered or suppressed. Only email actions that occur outside of 
the Window's active time frame are carried out.

Pager 
Window

The Pager Window for the selected user. When you assign a Pager Window to a user 
or group, be sure to take note of the Pager Window Behavior option. 
Additional Information:  For more information about Schedules, see the Schedules 
and Windows topic.

Pager 
Window 
Behavior

Option Description

Perform actions 
that occur within 
the window

Only pager actions that occur during the Window's active time 
frame are carried out. Email actions that are triggered outside 
of the active time frame are suppressed.

Don't Perform 
actions that occur 
within the window

Pager actions that occur during the active time frame are 
filtered or suppressed. Only pager actions that occur outside 
of the Window's active time frame are carried out.

Login The Windows or SQL Authentication account for the user. You can associate a SQL 
Sentry user with a Windows or SQL Authentication account and restrict access to 
specific Sites, Target Groups, or instances, effectively limiting what the logged-in 
user can see within the client.

Additional Information:  For more information, see the SQL Sentry Client Security 
topic.

Description Descriptive text or notes for the user.

Groups The Available area lists any group within your SQL Sentry enterprise. The Selected 
area lists those groups that the user belongs to.
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Groups
Expand the Groups node in the Navigator pane to list any configured groups.

Note:  In versions 2020.8.31 and later, a default group named Default Alerts is created during 
the onboarding process and the user added during the onboarding process is automatically 
added to this group. This is the default contact group for Send Email actions.
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Adding or Editing a Group

Add a Group by completing the following steps:

 1. Right-click the Groups node, and then select New to open the Add a Group tab.

 2. Enter the applicable information for your Group, and then select  (Save toolbar button) to save 
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the new Group.

Edit an existing Group by completing the following steps:
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 1. Double click or right click an existing Group to open the Edit Group tab.

 2. Edit the applicable information for your Group, and then select  (Save toolbar button) to save 
your changes.
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Assigning User(s) to a Group

To assign users to the group, choose from the available users on the bottom-left side of the 
Properties view, and then select Add. Select Save in the top toolbar to save the group.
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Deleting or Disabling a Group

To delete or disable a group, right-click the desired group, and then select Disable Group. Disabled 
groups are grayed-out in the Navigator pane and have Disabled next to their name.
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Note:  When you disable a group, that group no longer receives notifications for any 
actions that they are the selected target of. Disabled groups are grayed-out in the 
Navigator pane, and they are also listed as Disabled.

Enabling a Group

To enable a group that has been disabled, use the right-click context menu of the group, and 
select Enable Group.
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Group Fields

When you create a new group or edit an existing group, the following fields are available:
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Field Description

Group Name The name assigned to a group. Required. 

Alert 
Window

When you assign an Alert Window to a group be sure to take note of the Alert 
Window Behavior option.
Additional Information:  For more information about Schedules, see the Schedules 
and Windows topic.
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Field Description

Alert 
Window 
Behavior

Option Description

Perform actions 
that occur within 
the window

Only email and pager actions that occur during the Window's 
active time frame are carried out. Actions that are triggered 
outside of the active time frame are suppressed.

Don't Perform 
action that occur 
within the 
window

Actions that occur during the active time frame are filtered or 
suppressed. Only email and pager actions that occur outside of 
the Window's active time frame are carried out.

Login The Windows active directory account for the group. You can associate a SQL Sentry 
group with a Windows active directory account and restrict access to specific sites, 
target groups, or instances, effectively limiting what the logged-in user can see within 
the client. For more information, see the SQL Sentry Client Security topic.

Description Descriptive text or notes for the user.

Users The Available area lists users within your SQL Sentry enterprise. The Selected area 
lists any users that belong to the group.

All Targets

The All Targets node is the root node of the SQL Sentry client and is located in the top position of the 
Navigator pane. All targets that are registered across the entire SQL Sentry enterprise are found 
within All Targets.

The All Targets node is used to configure global conditions and settings within the SQL Sentry 
Alerting and Responses System. The All Targets node is also used to view Event Calendar, 
Performance Overview, or AlwaysOn Management.
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All Targets Context Menu

 

Right-click on the All Targets node to access its context menu. The following commands are 
available:

Command Description

Open > Event Calendar Opens the global event manager view of your SQL Sentry 
enterprise.

Open > Performance Overview Opens the shared Performance Overview.

Open > AlwaysOn 
Management

Opens the AlwaysOn Management environment. 

Add > Site Adds a new Site node beneath the Shared Groups node.

Add > Connection Adds a new connection to the Default Site.
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Global Level of the Alerting and Response System
The All Targets node is used to configure global conditions and settings within the SQL Sentry 
Alerting and Responses System. When the All Targets node is selected in the Navigator pane, the 
associated global level Conditions and Settings pane is available. If you don't see the Conditions and 
Settings pane when the All Targets node is selected, use the View menu to bring up the desired pane. 
Conditions and settings configured at the All Targets level are global in nature. This means that when 
a condition or setting is set at the Shared Group level, it automatically propagates down throughout 
your SQL Sentry environment.
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For example, configure a send email action for the SQL Agent Job: Failure condition at the All Targets 
global level. An email is now sent anytime an agent job fails across your entire monitored 
environment.
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Once global conditions and settings are configured, more granular configurations can be made where 
they are needed at the lower levels. For more details on how global conditions and settings are 
inherited throughout your SQL Sentry environment, and information about configuring alerting for your 
SQL Sentry installation, see the Alerting and Responses System topic.

Global Views
Access global views in your SQL Sentry enterprise through the All Targets node. This is done by either 
double-clicking the All Targets node or by using its right-click context menu. 

The default number of days for the Global Calendar view is one day and can be adjusted in User 
Preferences.

The primary purpose of the global views is to give you insight into what's happening across your 
enterprise without having to open individual Event Calendars or Performance Analysis Dashboards at 
the target level.
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Note:  Future and running events are disabled in the global Event Calendar view. Adjust the 
runtime filter and other filter criteria on the Event View filter tab to further refine the display for 
personal preferences. 

For more information about the shared targets performance analysis overview, see the 
Performance Analysis Overview topic.

All Targets Child Nodes

Default Site

Sites represent a logical grouping of targets, instances, and monitoring services within your SQL 
Sentry environment. If you're upgrading from a previous version of SQL Sentry, you'll notice that the 
sites displayed beneath the All Targets node directly reflect those sites you previously configured 
within the Site Configuration node. If you're a new user, notice that the instances added using the 
quick start wizard are all contained in the Default Site node.

When a Site node is selected in the Navigator pane, the associated site level Conditions and Settings 
pane are available. If you don't see the Conditions and Settings pane when the Site node is selected, 
use the View menu to bring up the desired pane.

Note:  Conditions and settings configured at the site level apply to all targets, instances, and 
objects in that site. This means that when a condition or setting is configured at the site level, it 
automatically propagates down throughout that site.

Site Context Menu

Right-click on any Site node to access its context menu. The following commands are available:
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Command Description

Add > Target Adds a new target to the selected site.

Add > Group Adds a new target group to the selected site.

Add > 
Connection

Adds a new connection to the selected site.

Delete Site Deletes a site from the Shared Group node. Any targets or groups contained within 
the site must be deleted before a site can be deleted. This command is not 
available from the Default Site node.

Warning:  Selecting Delete Target is permanent. For more information, see the 
Targets topic.

Rename Site Renames the currently selected site.
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Command Description

Open
Performance 
Analysis

Opens a performance analysis overview for every target in the site.

Open 
AlwaysOn 
Management

Opens the AlwaysOn Management environment.

Show System 
Status

Shows the system status for the selected site. 

Add Advisory 
Condition 
>Target

Adds a target to an Advisory Condition. 

Snooze Alerts 
For > Time

Allows you to select a time or day for when to snooze alerts. 

Monitoring Services

Beneath the DefaultSite node is a Monitoring Services node. The Monitoring Services node contains 
the monitoring service(s), identified by their associated target name(s) that are responsible for 
collecting information pertaining to the site.

Note:  The SQL Sentry monitoring service is a Windows service that's responsible for collecting 
event history, event status, and performance related information and storing that information in 
the SQL Sentry database. Monitoring services are also responsible for sending notifications 
based on events.

The Monitoring service(s) within a site are responsible for gathering information about those watched 
targets and instances contained within that same site. Assign available monitoring services to sites 
either through the Site Configuration node or by dragging and dropping a monitoring service within 
the Navigator pane. This enables you to control exactly which monitoring services watch what 
targets. 
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Note:  Monitoring services can be critical for scenarios where you have multiple servers located 
at different geographic locations. Having a monitoring service for each geographic location 
minimizes network traffic across the WAN.

Additional Information:  For more information, see the monitoring service and site configuration 
topics.

Targets Nodes
Beneath every Site node are its associated Target nodes, identified with the target's full name, usually 
ComputerName.DomainName. Each Target node represents a physical computer, commonly a 
Windows server within your SQL Sentry environment. Commonly beneath every Target node in the 
Navigator pane are its associated instances.

Double-click any Target node to access its related Performance Analysis Dashboard or Event 
Calendar.
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Targets Context Menu

Right-click on any Target node to access its context menu. The following commands are available:
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Command Description

Open > Event 
Calendar

Opens the Event Calendar view for the associated target.

Open > 
Performance 
Analysis

Opens the Performance Analysis Dashboard for the associated target.

Show Windows 
Processes

Launches a Process Activity window similar to Windows Task Manager for the 
associated target.

Add > Instance Adds a new instance to the Default Site.

Delete Target Warning:  This command deletes the actual registration for the target from SQL 
Sentry. This includes the deletion of all historical information for any associated 
connections belonging to the target from the SQL Sentry database. This command 
is final and cannot be undone. Only use this command if you want to permanently 
delete information SQL Sentry has stored about the target and its associated 
connections from the SQL Sentry database.

When deleting a target, you must first stop watching the target and instances. See 
the Stop Watching Targets article for more information.

Jump to > 
Time

Allows you to select a date, time of day, and time frame for an Event Manager 
Calendar.

Scan for 
Configuration 
Changes

This scan looks for any hardware, network, or schema changes that have taken 
place on the target or its associated instances. This information is automatically 
gathered periodically.   

Target Conditions and Settings

Within the framework of the Alerting and Responses System Hierarchy, targets represent a level 
between sites and instances. This means that when a condition or setting is configured at a target 
level, it automatically propagates down to its associated instances and objects.

If you don't see the Conditions and Settings pane when a Target node is selected, use the View menu 
to bring up the desired pane.

Note:  Conditions and settings configured at the target level apply to all instances and objects 
beneath that target. This means that when a condition or setting is configured at the target 
level, it automatically propagates down to its associated instances and objects.
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Adding a Target to your Environment

Add a new target to your installation by selecting Add in the right-click context menu of any Site node.

Deleting a Target From Your Environment

Delete a target from your installation by selecting Delete Target in the right-click context menu of any 
Target node.

When deleting a target, you must first stop watching the target and instances. See the Stop Watching 
Targets article for more information.
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Warning:  The Delete Target command deletes the actual registration for the target from SQL 
Sentry. This includes the deletion of all historical information for any associated instances 
belonging to the target from the SQL Sentry database. This command is final and cannot be 
undone. Only use this command if you want to permanently delete information SQL Sentry has 
stored about the target and its associated instances from the SQL Sentry database. 
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Target Groups

Targets can be organized into target groups beneath any Site node. A target group allows you to 
create logical groups of devices for alerting, organizational, and display purposes. Use the Add Target 
Group command in the right-click context menu of any Site node to add a target group.
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Target Group Conditions and Settings

Within the framework of the Alerting and Responses System Hierarchy, target groups represent an 
intermediate level between the site and target. This means that when a condition or setting is 
configured at a target group level, it automatically propagates down to its associated targets, 
instances, and objects.

Instance Nodes
Contained beneath every Target node are its associated Instance nodes. Instances are identified by 
their target/instance name. Contained beneath every Instance node are its associated objects.
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Instances, Actions, and Settings

Within the framework of the Alerting and Responses System Hierarchy, instances represent the level 
above objects. This means that when a condition or setting is configured at an instance level, it 
automatically propagates down to its associated objects.

When an Instance node is selected in the Navigator pane, the associated instance level in the 
Conditions and Settings pane is available. If you don't see the Conditions and Settings pane when an 
Instance node is selected, use the View menu to bring up the desired pane.

Note:  Conditions and settings configured at the Instance level apply to all objects belonging to 
that instance. This means that when a condition or setting is configured at the instance level, it 
automatically propagates down to its associated objects.

Adding an Instance to Your Environment

Add additional monitored instances to your SQL Sentry environment by right-clicking either the All 
Targets node, a Site node, a Target Group node, or an existing Target node in the Navigator pane, and 
then select Add, or select File to add an instance. 
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In the Add dialog box, choose the desired instance type from the drop-down menu, and then select 
Connect. For more information, see the Monitoring Additional Targets topic.
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SQL Sentry Client Interface

The SQL Sentry client interface is divided into three main areas:

 l Positioned along the left side of the client are the Navigator, Event View, and Plan History panes. 
 l Positioned in the center of the client is the workspace area. The SQL Sentry client has been 

designed with an enhanced multiple document interface (MDI).
 l Positioned along the right side of the client are the Conditions and Settings panes.

Working With Panes
Panes within the SQL Sentry Client can be enabled or disabled.  The pushpin feature  can be used 
to auto-hide the panes allowing for a larger workspace area. These panes can be moved, docked, and 
resized allowing the workspace to be customized to best fit your work style. If the panes are closed 
they can easily be restored from the View menu.

Workspace Layout
The dimensions of the client panes and workspace area are saved automatically when you close the 
client. Select Tools > Reset Layout to restore the default configuration.
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Status Bar
At the bottom of the SQL Sentry client is a status bar divided into four sections: 

Status Bar 
Section Description

Left Section Current status for the active view. If you recently refreshed the time or went to a new 
window, it says Refreshing History Data or Refreshing Sample Data.

Middle 
Section

Current progress for the active view.

Right Section Displays if the software is up-to-date when the client has access to the internet.

Client Alerts 
Indicator

 l A red indicator means there are errors
 l A yellow indicator means there are warnings
 l A green indicator means there are no errors or warnings

Additional Information:  For more information about the Client Alerts indicator, see 
the Client Alerts article.

SQL Sentry Menu Options
The menus and toolbars are used to operate the SQL Sentry client. The options available within the 
menus vary depending on the active window. For more information about the toolbars, see the 
Toolbars topic.
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The following are descriptions of the commands found in the various SQL Sentry menus.

File Menu

Option Description Hotkey

New Target Adds a new target to the Navigator pane. N/A

New Plan Explorer 
Session

Opens a new Plan Explorer session. N/A

Open Opens execution plan files. N/A

Connect to an 
Installation

Specifies the SQL Sentry database and authentication 
information for the client.

N/A

Save Saves changes to the active window. CTRL + S

Save As Renames and saves the active view. N/A

Save View As Renames and saves the existing view. N/A

Close Closes the active window. CTRL + W

Export Data Exports event list views and various tabs of performance 
analysis.

CTRL + E

Page Setup Sets the page options for printing. N/A

Print Prints the active window. N/A
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Option Description Hotkey

Print Preview Previews the active window for printing, exporting, and send 
email options.

N/A

Recent Files Displays a list of recently opened Plan Explorer files. N/A

Exit Closes the SQL Sentry Client. CTRL + Q

View Menu

Option Description

Navigator Displays the Navigator pane.

Event View Displays the Event View pane.

Plan History Displays the Plan History pane.

Conditions Displays the Conditions pane.

Settings Displays the Settings pane.

Start Page Displays the Start Page.

Calendar Menu

Option Description

Show Conflicts Explores conflicts for specified time ranges.

View Style Selects the view style for the Event Calendar.
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Reports Menu
For more information about the reporting options in SQL Sentry, see the Reporting topic.

Option Description

Events Generate an Event Calendar associated report.

Performance Analysis Generate a Performance Analysis associated report.

General  Generate a General settings report.

Report Deployment 
Settings

Settings for the SQL Server report server location that deploys your 
reports.

Deploy Reports Deploys the reports to the location specified in the Report 
Deployment settings.

Import Reports Imports future reports created by the SQL Sentry development team.

Tools Menu 

Option Description Hotkey

User Preferences Opens the SQL Sentry Client User Preferences window and allows 
you to configure your preferences. 

CTRL + O
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Option Description Hotkey

Find Object Opens the Event Object Search window that finds event objects 
within the SQL Sentry client.

CTRL + F

Manage Response 
Rulesets

Opens all response rulesets for editing. N/A

Reset Event View 
Filter

Restores the event view filter settings to default. N/A

Reset Layout Restores the layout to default. N/A

Download Latest 
Custom Conditions 
Pack

Downloads the latest custom condition pack from SQL Sentry. N/A

Unsnooze All Allows all snoozed SQL Sentry actions to occur again. N/A

Run On-boarding 
Wizard (requires 
client restart) 

Opens the SQL Sentry setup wizard. N/A

Portal Opens the SQL Sentry Portal Access information window. The 
Window links to your SQL Sentry Portal connection and the SQL 
Sentry Portal configuration topic. 

 

Window Menu

Option Description

Cascade Cascades active windows in the workspace view.
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Option Description

Tile Vertical Tiles active windows vertically in the workspace view.

Tile Horizontal Tiles active windows horizontally in the workspace view.

Tabbed Displays active windows on tabs in the workspace view.

Show Tabs on 
Multiple Lines

Displays multiple rows of tabs.

Auto-rotate 
Performance 
Advisor Tabs

Auto-rotates through the active performance analysis windows when enabled. The 
rotation doesn't change the active tab of a performance analysis window. 
Whichever tab is selected as active refreshes as the windows rotate.  

Active 
Windows 
Name

Displays all active windows.

Help Menu

Option Description Hotkey

SQL 
Sentry 
Help

Opens the SQL Sentry user documentation. CTRL + H 
or F1

Check for 
Updates

Connects with SQL Sentry's online database and verifies that you have the 
latest version.

N/A

Manage 
Licenses

Opens the SolarWinds License Manager where you can view and manage 
SQL Sentry licenses.

N/A

Logging Options to enable trace logging for the SQL Sentry client and monitoring 
service for troubleshooting purposes. Contact support before you enable 
logging. Logs are stored in the interactive user's AppData\Local\SentryOne 
directory.

N/A
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Option Description Hotkey

About Displays current version, licensing information, and expiration.   N/A

SQL Sentry Toolbars

Save and Print Toolbar Buttons
The following describes the Save and Print toolbar buttons:

Button Name Description

Save Universal save button.

Print Preview Displays a print preview window for the selected object.

Print Prints the selected object.

New Plan Explorer Session Opens a New Plan Explorer session window.

Open Plan File Open an existing Plan Explorer session file.

Navigation Toolbar

The Navigation toolbar is used for navigating throughout the calendar view as well as performance 
graphs and runtime stats, and it changes depending on what you're viewing.

Note:  The date and time text are highlighted in bold when the time crosses a clock change (i.e. 
Daylight Saving Time). In 2021, Daylight Saving Time began on March 14 at 2:00 AM. When the 
time range crosses that period, it appears in bold text.
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Date/Time Selector
The date/time selector controls allow you to jump to a specific date or time and select the desired 
time interval.

Button Name Description

Date 
Selector

Selects the date to view on the calendar.

Time 
Selector

Selects the time to view on the calendar.

Go Moves the calendar to display the time selected in the date/time 
selector, maintaining the currently selected interval.

Go to 
Current 
Time

Jumps directly to the current time, maintaining the current selected 
time slice and interval, unless the interval is greater than one hour in 
which case one hour is used.

When you select the date selector, a small calendar appears. Select any day and select the right and 
left arrows to change the month. Select the bold today text at the bottom to auto-select the current 
day. You can also enter values for the day or year directly.

To navigate to a specific time on the selected day, select the time selector by choosing a time 
increment (hour, minute, etc.), use the up/down arrow, or type in a new value.

Important:  The workspace view doesn't refresh until you have completed your selections and 
select Go.

Interval Selector
The interval selector is used to zoom the current time interval in or out.

Button Name Description

One Minute View Displays the calendar in a one-minute interval.

Ten Minute View Displays the calendar in a 10-minute interval.

One Hour View Displays the calendar in a one-hour interval.

Four Hour View Displays the calendar in a four-hour interval.

One Day Displays the calendar in a one-day interval.
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Miscellaneous Controls

Button Name Description

Days 
Selector

Sets the total range of days to display on the calendar or graph. Select 
either arrow to decrease or increase the value, or type in a new value. 
The maximum value is 30 days. The currently selected interval (one 
minute to four hours) as well as the start time of the range is maintained 
when changing the number of days

Previous 
Interval

Navigates backward in time to the previous interval.

Previous 
Small 
Interval

Navigates backward in time using a smaller interval.

Next 
Interval

Navigates forward in time to the next interval.

Next 
Small 
Interval

Navigates forward in time using a smaller interval.

Refresh Refreshes the active workspace view by retrieving the latest information 
from the SQL Sentry database.

Hold down the CTRL key when you select it to force a hard refresh. This 
causes the SQL Sentry client to connect directly to and collect event data 
from the target instance in case the monitoring service is down. 

Note:  Not available on custom event views or views with multiple 
instances.

View 
Conflicts

Displays all schedule conflicts for the selected instance. For more 
information, see the Conflict Viewer topic.

View Toolbar
Select from the Calendar, List, or Split views. The active range note changes only the format in which 
the event data displays. For more information, see the Calendar view topic.
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Performance Analysis Toolbar

The performance analysis tabs can be synchronized to view performance data for a historical period 
or in a real time mode for the previous 10 minutes. This is coordinated using the toolbar. See the 
following toolbar chart: 

# Name Description

1 Print Preview Print preview is not active in performance analysis.

2 Print Print function is not active in performance analysis.

3 New Plan Explorer 
Session

Opens a new Plan Explorer session.

4 Open Plan File Opens an execution plan file.

5 Save Saves an execution plan file.

6 Start Date Sets the beginning date for viewing a range of performance 
related data.

7 Start Time Sets the beginning time for viewing a range of performance 
related data

8 End Date Sets the end date for viewing a range of performance related 
data.

9 End Time Sets the end time for viewing a range of performance related 
data.

10 Go Activates the selected start/end time range.

11 Go To Current Time Moves forward so that the display range ends at the current time.

12 Zoom Out Increases the date range.

13 Zoom In Decreases the date range.

14 Previous Interval Skips back in time one full interval.

15 Previous Small Interval Skips back in time one small unit of the interval scale.

16 Next Small Interval Skips forward in time one small unit of the interval scale.

17 Next Interval Skips forward in time a full interval.
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# Name Description

18 Synchronize Tabs Automatically sets all tabs to the active date range (enabled by 
default).

19 Start Auto-refresh Enables automatic updating of real time data for the current tab, 
or all tabs if synchronize tabs is enabled.

20 Pause Auto-refresh Pauses automatic updating of real time data for the current tab, 
or all tabs if synchronize tabs is enabled.

21 Refresh Refreshes the active view by retrieving the latest data for the 
active date range.

22 Show History Toggles between history and sample modes when on the 
dashboard.

23 Show Windows 
Processes

Opens the current Windows processes for the server.

24 Jump to Calendar Opens the calendar tab in the workspace area.

25 Show Custom Condition 
Markers

Enables and disables custom condition glyphs and event markers

26 Show Windows + SQL 
Server Performance

Opens a Windows + SQL Server Performance report.

SQL Sentry Hot Key List
The following are the hot keys that are available in SQL Sentry:

Item Keys Notes

Help F1 or Ctrl + 
H

Opens the User Guide.

Save Ctrl + S Saves changes made in the client.

Close Ctrl + W Closes the active tab in the client.

Exit Ctrl + Q Closes the client.

User Preferences Ctrl + O Opens User Preferences.

Print Ctrl + P Opens the Print window.

Find Object Ctrl + F Opens the Event Object Search window.
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Item Keys Notes

Tab Scroll Ctrl + Tab Scrolls through open tabs in the client.

Select All Ctrl + A Selects all items in the window (where applicable).

Copy Ctrl + C Copies selected items to the clipboard (where applicable).

Paste Ctrl + V Pastes items from the clipboard (where applicable).

Add Note
On note dialog:
- New

- Save

- Delete

- Close

Ctrl + Alt + 
N
On note 
dialog:
- Ctrl + N

- Ctrl + S

- Ctrl + D

- Ctrl + C

Opens the notes interface when an applicable object is selected. 
On note dialog:

- Opens new note.

- Saves note.

- Deletes note.

- Closes note dialog.

History List (one 
day)

Ctrl + Alt + 
H

Opens the History List view for one day when an applicable object 
is selected.

SQL Sentry Navigator Pane 

Navigator Pane Overview
The Navigator pane is the tree-view pane positioned on the left side of the client by default. The 
various nodes within the Navigator pane are used as the starting point in directing many functions of 
the SQL Sentry client, such as viewing an event calendar or a performance analysis dashboard. The 
navigator nodes are also used as the starting point to access the various levels of conditions and 
settings within the Alerting and Responses System. Right-clicking on a node accesses its context 
menu.
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Navigator Pane Elements
Each object in your SQL Sentry enterprise has an associated icon. Several of the node icons in the 
Navigator pane vary based on conditions, such as instance or watched status.

Instance Status

Button Description

Indicates that the instance has an online status.

Indicates that the instance has an offline status.

Indicates that the instance requires attention. Often associated with the SQL Server 
agent being offline.

Indicates that the instance has a watched status, but it isn't being actively monitored. 
This can happen if the monitoring service has stopped or the instance belongs to a site 
without an active monitoring service.
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Note:  Instance status is determined by the SQL Sentry Monitoring Service's ability to collect 
information from the instance.

The following is a simplified version of how instance status information is obtained and displayed in 
the SQL Sentry client.

 1. The SQL Sentry monitoring service gathers instance status information.

 2. The instance status information is written to the SQL Sentry database.

 3. The SQL Sentry client retrieves the instance status information from the database and displays 
it.

Note:  Select any instance node to access additional status information. A tool tip displays the 
status (offline/online), the last monitoring service, instance time, and any applicable error 
information.

Watched Status

Important:  A target must be set to watched before SQL Sentry begins monitoring it.

To watch a target, right-click the target. 
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You can also hide unwatched targets so they don't display in the Navigator pane by selecting Tools > 
UserPreferences > Navigator > HideUnwatchedInstances. For more information about watching 
targets and objects, see the Watching Instances and Objects topic.
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Button Description

Indicates that the instance/object isn't being watched.

Indicates that instance/object is being watched.
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Instance Icons

Instance types are represented with various icons. 

Button Description

SQL server instance

Analysis services instance

Windows instance

Red Text in the Navigator Pane

If the label text for a node is red it indicates that an event object has a recent failure. Failures cascade 
from the object level up to the highest group level containing the object. 

Right-click on the event object, and select Cleared Failed Status to clear a job failure.
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Adjust how long failures display in the Navigator pane through Tools > User Preferences > Navigator 
> Highlight Event Failures in Navigator for.
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Snoozing Objects in the Navigator Pane

All Targets (global), sites, groups, and targets, can be snoozed with a right-click context menu in the 
Navigator pane. Snoozing an object prevents any SQL Sentry actions from occurring while the snooze 
is in effect. The snooze status is inherited by objects lower in the hierarchy. For example, snoozing 
the All Targets (global) node effectively stops all SQL Sentry actions in the environment for the 
duration of the snooze.

End snooze early by right-clicking a snoozed object.
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Note:  Monitor the Snooze status of an object with the Audit: Settings Changedaudit condition 
and Log to Database action. With this condition and action configured, changing the Snooze 
status of an object results in a record of this change logged to the database. For more 
information about snoozing an object, see the Conditions pane topic.

SQL Sentry Conditions Pane

Overview 
The Conditions pane is displayed on the right side of the SQL Sentry client by default, and its scope is 
determined by items selected in the Navigator pane. The Conditions pane is used to configure 
actions in response to conditions being met as part of the SQL Sentry Alerting and Response System. 
Actions can be defined in response to certain conditions being met within your environment. Choose 
from a variety of actions, depending on which condition is being responded to.

All conditions work on the principle of inheritance. This means that if you configure an action in 
response to a condition being met at the global level (All Targets), it automatically passes down to all 
applicable objects beneath it. Define global conditions for the most common issues across your 
environment once and have those passed down to every monitored server automatically. Further 
refine conditions at each level as needed. For a visual representation of how inheritance works within 
SQL Sentry, see the alerting and response system hierarchy diagram.

Each condition that you configure in your environment will have an associated behavior. The behavior 
controls how the condition is carried out relative to any inherited conditions. There are three condition 
behaviors available:

 l Override inherited actions
 l Combine with inherited actions
 l Disabled

For a complete explanation and example usage scenarios for each behavior, see the Action Behavior 
topic.

View Menu
The Conditions pane is displayed on the right side of the screen by default. If you don't see the 
Conditions pane, use the View menu (View > Conditions). Each condition type has an associated 
actions tab where actions can be configured in response to conditions being met. The following are 
types of conditions: 
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Condition 
Type Description Additional Info

Inherited 
Condition

Displays the configured actions 
that are inherited by the currently 
selected object.

 l Configured actions in the Inherited section 
have a status column that indicates if they 
apply to the currently selected object.

 l Configured actions with an enabled status 
have green text.

 l Configured actions with a disabled status 
are grayed out.

Explicit Displays the configured actions 
that are explicitly set at the 
current object level.

 l An action that is explicitly disabled has red 
text.

 l Configured actions with an enabled status 
have green text.

SQL Sentry Conditions Pane

page 194Getting Started Guide: SQL Sentry



Snoozing a Condition/Action 
Conditions/Actions can be snoozed or suppressed for a period of time by right-clicking on the 
condition/action in the Conditions pane and selecting one of the following options:
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Snooze Context Menu Option Description

Snooze this Condition/Action 
Combination

Snoozes the specific condition/action that is selected.

Snooze this Condition for All 
Actions

Snoozes all instances of the selected condition regardless of the 
action assigned to it.

Snooze this Action for All 
Conditions

Snoozes all instances of the selected action regardless of the 
condition assigned to it.

Additionally, select whether the snooze affects just the hierarchical object that you selected (site, 
group, target, or instance) or if it affects all objects.

Note:  Conditions that have been snoozed have a gray background in the Conditions pane.

Once a condition/action is snoozed, right-click on the snoozed object and select Unsnooze to 
unsnooze the object. 

Alternatively, unsnooze all snoozed conditions/actions through Tools > Unsnooze All.
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SQL Sentry Event Calendar View

Event Calendar Pane
The Event Calendar pane is used to filter what is shown in the event calendar. Select the Event 
Calendar tab at the bottom of the Navigator pane to open the Event Calendar, or select View > Event 
Calendar.
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Note:  The Event Calendar tab is active when viewing the event calendar. The tabs at the top 
help to filter items in the event calendar.

The following are descriptions for the various Event Calendar tabs:

Event Calendar 
tab Description

Filter Used for general filter settings including run status, review status, duration, and 
open text filters.

Properties Displays a description of the view along with time settings and an object count.

Connections Displays the instances and instance text filters for the current view.

Objects Displays individual event objects added to the current view.

Event Sources Allows you to determine the display properties of each event source.

Tab Formatting

The formatting of the tab text indicates whether certain filters are enabled or disabled:

 l If an event source is deselected, the tab name is gray. 
 l If any objects or categories are selected for a source, the tab name is bold. 
 l Additionally, any runtime or other filters set on the filter tab cause that tab name to bold.

Activating Filters

After making filter selections, activate the filter by selecting Apply Filter near the bottom of the filter 
menu. When the filter is active, Apply Filter has a blue background.

Note:  Runtime filters don't affect status event objects.

Using Text Filters

Multiple keywords are separated with a semicolon ( ; ). A plus sign ( + ) is used in front of any keyword
(s) that you want to apply using an And operator. Otherwise the keyword is applied with an Or 
operator. Text filters can be applied to the following:

 l The event object name
 l The step text
 l The name of the object owner
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Note:  If filters are entered in two or more of these text boxes, they will be applied with an 
And operator.

Removing Filters

Any filter settings can be removed from the active view by selecting Remove Filter. 

Note:  The Remove Filter button isn't available on custom Event Calendars and other views 
containing multiple instances. This ensures a filter is always applied to these views, minimizing 
the chance of overloading the SQL Sentry client with too much event data.

Saving a Filter as a View

To save the active filter settings to a custom Event Calendar, select Save View As from the File menu.

Properties Tab
The Properties tab displays basic descriptive information about the current view. Additionally, this tab 
provides controls to set the default time slice for this view. This allows you to specify the number of 
days, amount of time, and start time shown for this view every time it is opened.
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Note:  When a performance monitor is placed on a custom Event Calendar, it is applied to all 
monitorable objects within the view. The View Totals box, at the bottom, allows you to see 
exactly how many objects are monitored.

The following are descriptions of the view totals values:

View Total 
Value Description

Connections Total number of SQL Server instances and Windows instances associated with the 
view.

Objects From 
Instances

Gives a count of all objects from those instances that meet the filter criteria.

Individual 
Objects

Number of objects added by the Edit Individual Objects button.

Total Objects Total objects in the view.

Getting Started Guide: SQL Sentry page 201

SQL Sentry Event Calendar View



View Total 
Value Description

Total 
Monitored 
Objects

Total amount of objects that actually have performance monitors attached to them.

Total 
Monitorable

Total number of objects that have performance monitors attached to them (SQL 
agent jobs, reporting services reports, and Windows tasks).

SQL Sentry Settings Pane

Introduction
The Settings pane is where settings are configured for instances, sources, and objects. This tab is 
also where performance counter thresholds are configured when a counter is selected. Settings can 
be configured globally, at the instance level, or at the object level, and just like conditions, they work 
on the principle of inheritance. The scope is determined by items selected in the Navigator pane. For 
more information, see the Conditions pane topic.

Opening the Settings Pane

The Settings pane and Navigator pane are docked on the Start Page of the SQL Sentry client by 
default. Select the Settings tab to display the settings pane.
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Note:  If the Settings pane does not open on your default installation, select View > Settings on 
the toolbar to display it. Select the desired site, group, target, or instance to begin configuring 
your settings.

Amazon RDS for SQL Server
The following settings are configurable for Amazon RDS for SQL Server:

Amazon RDS for SQL Server
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Miscellaneous Settings

Setting Definition Level Con-
figurable

Auto-enable SQL 
Server Agent 
Tokens

Whether or not to enable SQL Server Agent Tokens on 
SQL Server 2005 instances.

 l Global

Auto-recycle large 
SQL Server Agent 
Logs

Whether or not to automatically recycle large agent log 
files in SQL Server 2005 or greater.

 l Global

Collect Session 
TempDB Usage

Set to True to turn on data collection for TempDB Usage 
and populate the TempDB Session Usage table.

 l Global
 l Site/Group
 l Target

Collect TempDB 
Object Stats

Set to True to turn on data collection for TempDB Usage 
and populate the TempDB Object Stats charts.

See the Troubleshooting article for more guidance on this 
setting.

 l Global
 l Site/Group
 l Target

Maximum Queue 
Length

The maximum number of objects that can be queued at 
one time. This setting always applies to the connection 
level.

 l Global
 l Site/Group
 l Target

Inherit from Parent 
(Global)

Specifies whether miscellaneous settings are inherited 
from the parent object.

 l Site/Group
 l Target

Synchronization

Setting Definition Level Con-
figurable

Max User Databases to 
Synchronize (largest first)

The maximum number of databases to 
synchronize, ordered by total size. This includes 
system databases.

 l Global
 l Site/Group
 l Target

Max User Database Files to 
Synchronize ( most active & 
largest first)

The maximum number of user database files to 
synchronize (most active & largest first).

 l Global
 l Site/Group
 l Target

Inherit from Parent (Global) Specifies whether Synchronization settings are 
inherited from the parent object.

 l Site/Group
 l Target
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Maintenance Window

Setting Definition Level Con-
figurable

Maintenance 
Window

The maintenance window for watched instances. Only Log 
actions will be triggered for Failsafe conditions inside the 
maintenance window. Send, Execute, and other actions will not 
be triggered.

 l Global
 l Site/Group
 l Target

Inherit from 
Parent 
(Global)

Specifies whether Maintenance Window settings are inherited 
from the parent object.

 l Site/Group
 l Target

Databases Source

General Settings

Setting  Definition Level Con-
figurable

Enable Table/ 
Index Data 
Collection

Specifies whether table and index collection is enabled. If 
disabled no index management functions will be performed.

 l Global
 l Site/Group
 l Target
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Setting  Definition Level Con-
figurable

Max Partitions 
to Collect Per 
Database

The maximum partitions to collect.  l Global
 l Site/Group
 l Target

Min Index Size 
(MB) to Collect 
Fragmentation 
Data

The minimum size of the index in MB to be considered for 
defrag.

 l Global
 l Site/Group
 l Target

Max Index Size 
(MB) to Collect 
Fragmentation 
Data

The maximum size of the index in MB to be considered for 
defrag.

 l Global
 l Site/Group
 l Target

Collect Buffer 
Data when 
Buffer >8GB

Collecting detailed buffer information is inherently a low 
overhead process. However, since it takes approximately 1 
second per GB of buffer, on larger buffers the associated 
query can take some time to complete, which may cause it to 
appear in Top SQL and or generate associated alerts. It is 
generally safe to enable this setting, since SQL Sentry ensures 
that the total time spent per day collecting buffer data will be 
roughly the same regardless of buffer size, and that collection 
only occurs when the buffer has changed.

 l Global
 l Site/Group
 l Target

Inherit From 
Parent

Specifies whether the general database source settings are 
inherited from the parent object.

 l Site/Group
 l Target
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Deadlocks Source

Synchronization

Setting Definition Level Con-
figurable

History Filter The filter used for history synchronization. Only events that 
meet the filter will be written to the database.

 l Global
 l Site/Group
 l Target

Inherit from 
Parent (Global)

Specifies whether the maximum row count settings are 
inherited from the parent object.

 l Site/Group
 l Target

Collection Settings

Setting Definition Level Con-
figurable

Collect Deadlock 
Events

Specifies whether the deadlock statement collection is 
enabled.

 l Global
 l Site/Group
 l Target

Inherit from Parent 
(Global)

Specifies whether the deadlock settings are inherited 
from the parent object.

 l Site/Group
 l Target

Getting Started Guide: SQL Sentry page 207

SQL Sentry Settings Pane



Index Defragmentation

General Defrag Settings

Setting Definition Level Con-
figurable

Primary 
Schedule

The schedule on which index analysis and or defrag will be 
performed, according to the configured reorg and rebuild 
thresholds.

 l Global
 l Site/Group
 l Target

Operation Type Options for Analyze Only and Analyze & Defrag.

See the Fragmentation Manager article for more details.

 l Global
 l Site/Group
 l Target
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Setting Definition Level Con-
figurable

Reanalyze 
Indexes After 
Defrag

Specifies whether to run the fragmentation analysis again 
after defrag.

 l Global
 l Site/Group
 l Target

Fragmentation 
Scan Mode

The scan mode used when scanning for fragmentation.  l Global
 l Site/Group
 l Target

Maximum 
Concurrent 
Operations

The maximum concurrent operations to run on a SQL Server 
Instance.

 l Global
 l Site/Group
 l Target

Delay Between 
Defrag 
Operations

When Maximum Concurrent Operations is set to 1, you can 
specify a delay between defrag operations to prevent 
send/redo queue overload when availability groups or 
mirroring are in use.

 l Global
 l Site/Group
 l Target

Maximum 
Duration

The maximum allowed runtime for the defragmentation 
process.

 l Global
 l Site/Group
 l Target

Partitions 
(Enterprise 
Only)

Which partitions to include for defragmentation.  l Global
 l Site/Group
 l Target

Inherit From 
Parent (Global)

Specifies whether the general database settings are inherited 
from the parent object.

 l Site/Group
 l Target

Index Reorg Settings

Setting Definition Level Con-
figurable

Reorg 
Threshold 
%

The maximum fragmentation percentage before an index reorg is 
performed.

 l Global
 l Site/Group
 l Target

Reorg 
Schedule

Dedicated schedule on which reorgs only will be performed, 
according to the reorg threshold. Rebuilds will not be performed 
even if the rebuild threshold has been exceeded.

 l Global
 l Site/Group
 l Target
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Setting Definition Level Con-
figurable

Inherit 
From 
Parent 
(Global)

Specifies whether the index reorg settings are inherited from the 
parent object.

 l Site/Group
 l Target

Index Rebuild Settings

Setting Definition Level Con-
figurable

Rebuild 
Threshold %

The maximum fragmentation percentage before an index 
rebuild is performed.

 l Global
 l Site/Group
 l Target

Rebuild 
Schedule

Dedicated schedule on which rebuilds only (online or offline) 
will be performed, according to the rebuild threshold.

 l Global
 l Site/Group
 l Target

Offline Rebuild 
Window

If an offline rebuild will be performed as the result of the 
primary schedule, then only start the offline rebuild during 
this window.

 l Global
 l Site/Group
 l Target

Sort in tempdb Specifies whether to use the tempdb for sorting.  l Global
 l Site/Group
 l Target

Use Online 
Rebuild 
(Enterprise Only)

Specifies whether to rebuild the index while online (Enterprise 
Only).

 l Global
 l Site/Group
 l Target

MAXDOP 
(Enterprise Only)

The max degree of parallelism to use during the rebuild.  l Global
 l Site/Group
 l Target

Inherit From 
Parent (Global)

Specifies whether the index reorg settings are inherited from 
the parent object.

 l Site/Group
 l Target
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Top SQL

Runtime Thresholds

Setting Definition Level Con-
figurable

Maximum Duration 
Threshold

The maximum allowed duration for the object.  l Global
 l Site/Group
 l Target

Maximum Duration 
Threshold Percent

The maximum allowed duration percentage for the 
object.

 l Global
 l Site/Group
 l Target

Minimum Duration 
Threshold

The minimum allowed duration for the object.  l Global
 l Site/Group
 l Target

Minimum Duration 
Threshold Percent

The minimum allowed duration percentage for the 
object.

 l Global
 l Site/Group
 l Target

Inherit From Parent Specifies whether the duration thresholds settings are 
inherited from the parent object.

 l Site/Group
 l Target
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Top SQL Source

Collection Settings

Setting Definition Level Con-
figurable

Minimum 
Duration

The minimum required duration for a statement to be logged.  l Global
 l Site/Group
 l Target

Minimum 
CPU

The minimum required CPU for a statement to be logged.  l Global
 l Site/Group
 l Target

Minimum 
Reads

The minimum reads required for a statement to be logged.  l Global
 l Site/Group
 l Target
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Setting Definition Level Con-
figurable

Minimum 
Writes

The minimum required writes for a statement to be logged.  l Global
 l Site/Group
 l Target

Collect 
Trace 
Events

Specifies whether traces events are collected.  l Global
 l Site/Group
 l Target

Collect 
Statement 
Events

Specifies whether statement events are collected.  l Global
 l Site/Group
 l Target

Running 
Events 
Polling 
Interval

Specifies how often the service checks for running events.  l Global
 l Site/Group
 l Target

Collect 
Execution 
Plans

Specifies whether execution plans are collected. Running queries 
will not be captured if this is set to false.

 l Global
 l Site/Group
 l Target

Max Plan 
Size to 
Collect 
(MB)

Specifies the max plan size to collect in MB.  l Global
 l Site/Group
 l Target

Collect 
Query Stats

Specifies whether query stats collection is enabled.  l Global
 l Site/Group
 l Target

Query Stats 
Sample 
Interval

Specifies how often to sample query stats.  l Global
 l Site/Group
 l Target

Filter Time 
Span

The Filter Time Span specifies the base length of time over which 
the collection filters will be applied to Query Stats. See Filter 
Factor for more details.

 l Global
 l Site/Group
 l Target
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Setting Definition Level Con-
figurable

Filter Factor The Filter Factor is calculated by dividing the Query Stats Sample 
Interval by the Filter Time Span. The collection filters such as 
Minimum Duration are multiplied by this value when applied to 
Query Stats collection. For example, using the defaults (Query 
Stats Sample Interval = 60 Seconds, Filter Time Span = 30 
Seconds, Minimum Duration = 5 Seconds) the total cumulative 
duration of all executions of a query over the 60 second sample 
interval must be greater than 10 seconds.

 l Global
 l Site/Group
 l Target

Inherit 
From 
Parent 
(Global)

Specifies whether the Top SQL settings are inherited from the 
parent object.

 l Site/Group
 l Target

AI Query 
Assist 
Enabled

Determines whether AI Query Assist is enabled or disabled. This 
setting must be set to True for AI Query Assist to be enabled. 

 l Global
 l Site/Group
 l Target

Analytics Platform System Instance
The following settings are configurable for Analytics Platform System instances:

Analytics Platform System
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Collection Settings

Setting Definition Level Con-
figurable

Monitor 
Performance

Controls whether performance monitoring is enabled. Global Site/Group 
Target

Inherit From Parent 
(Global)

Specifies whether collection settings are inherited from 
the parent object.

Site/Group Target

Maintenance Window

Setting Definition Level Con-
figurable

Maintenance 
Window

The maintenance window for targets. Only Log actions will be 
triggered for Failsafe conditions inside the maintenance 
window. Send, Execute, and other actions will not be triggered.

 l Global
 l Site/Group
 l Target

Inherit From 
Parent 
(Global)

Specifies whether maintenance window settings are inherited 
from the parent object.

 l Site/Group
 l Target

APS Distributed Queries
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Runtime Thresholds

Setting Definition Level Con-
figurable

Maximum Duration 
Threshold

The maximum allowed duration for the object.  l Global
 l Site/Group
 l Target

Minimum Duration 
Threshold

The minimum allowed duration for the object.  l Global
 l Site/Group
 l Target

Inherit From Parent 
(Global)

Specifies whether the duration threshold settings are 
inherited from the parent object.

 l Site/Group
 l Target

APS Distributed Queries Source

Queries Settings

Setting Definition Level Con-
figurable

Minimum Duration The minimum required duration for a statement to 
be logged.

 l Global
 l Site/Group
 l Target
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Setting Definition Level Con-
figurable

SQL Request Plan 
Collection Enabled

This will enable collection of compute node level 
execution plans.

 l Global
 l Site/Group
 l Target

Collect Distributed 
Queries Errors

This will collect and show errors for distributed 
queries.

 l Global
 l Site/Group
 l Target

Inherit From Parent 
(Global)

Specifies whether the Top SQL Settings are inherited 
from the parent object.

 l Site/Group
 l Target

APS Health Alerts Source

Synchronization

Setting Definition Level Con-
figurable

History Filter The filter used for history synchronization. Only events that 
meet the filter will be written to the database.

 l Global
 l Site/Group
 l Target

Inherit From 
Parent (Global)

Specifies whether the maximum row count settings are 
inherited from the parent object.

 l Site/Group
 l Target
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APS Loader Backup Run

Runtime Thresholds

Setting Definition Level Con-
figurable

Maximum Duration 
Threshold

The maximum allowed duration for the object.  l Global
 l Site/Group
 l Target

Maximum Duration 
Threshold Percent

The maximum allowed duration percentage for the 
object.

 l Global
 l Site/Group
 l Target

Minimum Duration 
Threshold

The minimum allowed duration for the object.  l Global
 l Site/Group
 l Target

Minimum Duration 
Threshold Percent

The minimum allowed duration percentage for the 
object.

 l Global
 l Site/Group
 l Target

Inherit From Parent 
(Global)

Specifies whether the duration threshold settings are 
inherited from the parent object.

 l Site/Group
 l Target
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Azure SQL Data Warehouse Instance
The following settings are configurable for Azure SQL Data Warehouse instances:

Azure SQL Data Warehouse

Collection Settings

Setting Definition Level Con-
figurable

Monitor Performance Controls whether performance monitoring is enabled.  l Global
 l Site/Group
 l Target

Inherit From Parent 
(Global)

Specifies whether collection settings are inherited from 
the parent object.

 l Site/Group
 l Target

Maintenance Window

Setting Definition Level Con-
figurable

Maintenance 
Window

The maintenance window for targets. Only Log actions will be 
triggered for Failsafe conditions inside the maintenance 
window. Send, Execute, and other actions will not be triggered.

 l Global
 l Site/Group
 l Target
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Setting Definition Level Con-
figurable

Inherit From 
Parent 
(Global)

Specifies whether maintenance window settings are inherited 
from the parent object.

 l Global
 l Site/Group
 l Target

Azure SQL Data Warehouse Distributed Queries

Runtime Thresholds

Setting Definition Level Con-
figurable

Maximum Duration 
Threshold

The maximum allowed duration for the object.  l Global
 l Site/Group
 l Target

Minimum Duration 
Threshold

The minimum allowed duration percentage for the object.  l Global
 l Site/Group
 l Target

Inherit From Parent 
(Global)

Specifies whether the duration threshold settings are 
inherited from the parent object.

 l Site/Group
 l Target
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Azure SQL Data Warehouse Distributed Queries Source

Queries Settings

Setting Definition Level Con-
figurable

Minimum Duration The minimum required duration for a statement to 
be logged.

 l Global
 l Site/Group
 l Target

SQL Request Plan 
Collection Enabled

This will enable collection of compute node level 
execution plans.

 l Global
 l Site/Group
 l Target

Collect Distributed 
Queries Errors

This will collect and show errors for distributed 
queries.

 l Global
 l Site/Group
 l Target

Inherit From Parent 
(Global)

Specifies whether the Top SQL settings are inherited 
from the parent object.

 l Site/Group
 l Target
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Azure SQL Data Warehouse Loader Backup Run

Runtime Thresholds

Setting Definition Level Con-
figurable

Maximum Duration 
Threshold

The maximum allowed duration for the object.  l Global
 l Site/Group
 l Target

Maximum Duration 
Threshold Percent

The maximum allowed duration percentage for the 
object.

 l Global
 l Site/Group
 l Target

Minimum Duration 
Threshold

The minimum allowed duration for the object.  l Global
 l Site/Group
 l Target

Minimum Duration 
Threshold Percent

The minimum allowed duration percentage for the 
object.

 l Global
 l Site/Group
 l Target

Inherit From Parent 
(Global)

Specifies whether the duration threshold settings are 
inherited from the parent object.

 l Site/Group
 l Target
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Azure SQL Database Instance
The following settings are configurable for Azure SQL Database instances:

Azure SQL Database

Miscellaneous

Note:  To provide the best experience, some features of monitoring an Azure SQL database 
require a few small tables and procedures to be stored in the target database. These objects 
are created and maintained in a SQL Sentry schema. If you choose not to allow the monitoring 
objects to be created, the features dependent upon them (e.g., Top SQL collection) are disabled 
for the target database. This is set to False by default, but it can be changed globally or over-
ridden at the target level.
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Setting Definition Level Con-
figurable

Allow SQL 
Sentry 
monitoring 
objects in 
target

In order to provide the best experience, some features of 
monitoring an Azure SQL Database require a few small tables and 
procedures to be stored in the target database. These objects will 
be created and maintained in a SQL Sentry schema. If you choose 
to not allow the monitoring objects to be created, the features 
dependent upon them will be disabled for the target database.

Additional Information:  See the Watched Target Objects article 
for a complete list of database objects that are placed on the 
watched target.

 l Global
 l Site/Group
 l Target

Collect 
Session 
TempDB 
Usage

Set to True to turn on data collection for TempDB Usage and 
populate the TempDB Session Usage table.

 l Global
 l Site/Group
 l Target

Collect 
TempDB 
Object Stats

Set to True to turn on data collection for TempDB Usage and 
populate the TempDB Object Stats charts.

See the Troubleshooting article for more guidance on this setting.

 l Global
 l Site/Group
 l Target

Inherit From 
Parent

Specifies whether miscellaneous settings are inherited from the 
parent object.

 l Site/Group
 l Target

Collection Settings

Setting Definition Level Con-
figurable

Monitor Performance Controls whether performance monitoring is enabled.  l Global
 l Site/Group
 l Target

Inherit From Parent 
(Global)

Specifies whether collection settings are inherited from 
the parent object. 

 l Site/Group
 l Target

SQL Sentry Settings Pane

page 224Getting Started Guide: SQL Sentry

watched-target-objects.htm
troubleshooting.htm


Maintenance Window

Setting Definition Level Con-
figurable

Maintenance 
Window

The maintenance window for targets. Only Log actions will be 
triggered for Failsafe conditions inside the maintenance 
window. Send, Execute, and other actions will not be triggered.

 l Global
 l Site/Group
 l Target

Inherit From 
Parent 
(Global)

Specifies whether maintenance window settings are inherited 
from the parent object. 

 l Site/Group
 l Target

Blocking SQL

Runtime Thresholds

Setting Definition Level Con-
figurable

Maximum Duration 
Threshold

The maximum allowed duration for the object.  l Global
 l Site/Group
 l Target

Inherit From Parent 
(Global)

Specifies whether the duration threshold settings are 
inherited from the parent object.

 l Site/Group
 l Target
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Blocking SQL Source

Collection Settings

Setting Definition Level Con-
figurable

Minimum Block 
Duration

The time required to trigger a block condition.  l Global
 l Site/Group
 l Target

Inherit From Parent 
(Global)

Specifies whether the blocking settings are inherited 
from the parent object.

 l Site/Group
 l Target
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Top SQL

Runtime Thresholds

Setting Definition Level Con-
figurable

Maximum Duration 
Threshold

The maximum allowed duration for the object.  l Global
 l Site/Group
 l Target

Maximum Duration 
Threshold Percent

The maximum allowed duration percentage for the 
object.

 l Global
 l Site/Group
 l Target

Minimum Duration 
Threshold

The minimum allowed duration for the object.  l Global
 l Site/Group
 l Target

Minimum Duration 
Threshold Percent

The minimum allowed duration percentage for the 
object.

 l Global
 l Site/Group
 l Target

Inherit From Parent 
(Global)

Specifies whether the duration threshold settings are 
inherited from the parent object.

 l Site/Group
 l Target
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Top SQL Source

Collection Settings

Setting Definition Level Con-
figurable

Minimum 
Duration

The minimum duration required for a statement to be logged.  l Global
 l Site/Group
 l Target

Minimum 
CPU

The minimum CPU required for a statement to be logged.  l Global
 l Site/Group
 l Target

Minimum 
Reads

The minimum required reads for a statement to be logged.  l Global
 l Site/Group
 l Target
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Setting Definition Level Con-
figurable

Minimum 
Writes

The minimum required writes for a statement to be logged.  l Global
 l Site/Group
 l Target

Collect 
Trace 
Events

Specifies whether trace events are collected.  l Global
 l Site/Group
 l Target

Collect 
Statement 
Events

Specifies whether statement events are collected.  l Global
 l Site/Group
 l Target

Running 
Events 
Polling 
Interval

Specifies how often the service checks for running events.  l Global
 l Site/Group
 l Target

Collect 
Execution 
Plans

Specifies whether execution plans are collected. Running queries 
will not be captured if set to false.

 l Global
 l Site/Group
 l Target

Max Plan 
Size to 
Collect 
(MB)

Specifies the max plan size to collect in MB.  l Global
 l Site/Group
 l Target

Collect 
Query Stats

Specifies whether query stats collection is enabled.  l Global
 l Site/Group
 l Target

Query Stats 
Sample 
Interval

Specifies how often to sample query stats.  l Global
 l Site/Group
 l Target

Filter Time 
Span

Specifies the base length of time over which the collection filters 
will be applied to Query Stats. See Filter Factor for more details.

 l Global
 l Site/Group
 l Target
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Setting Definition Level Con-
figurable

Filter Factor The Filter Factor is calculated by dividing the Query Stats Sample 
Interval by the Filter Time Span. The collection filters such as 
Minimum Duration are multiplied by this value when applied to 
Query Stats collection.

For example, using the defaults (Query Stats Sample Interval = 60 
Seconds, Filter Time Span = 30 Seconds, Minimum Duration = 5 
Seconds) the total cumulative duration of all executions of a query 
over the 60 second sample interval must be greater than 10 
seconds.

 l Global
 l Site/Group
 l Target

Inherit 
From 
Parent 
(Azure DB)

Specifies whether the Top SQL settings are inherited from the 
parent object.

 l Site/Group
 l Target

AI Query 
Assist 
Enabled

Determines whether AI Query Assist is enabled or disabled. This 
setting must be set to True for AI Query Assist to be enabled. 

 l Global
 l Site/Group
 l Target

Event Chain
The following settings are configurable for Event Chains:

Event Chain

Setting Definition Level Configurable

Maximum Runtime Threshold The maximum allowed runtime for the chain.  l Global

Minimum Runtime Threshold The minimum allowed runtime for the chain.  l Global

Event Chain Node
The following settings are configurable for Event Chain Nodes:
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Event Chain Node

Setting Definition Level Con-
figurable

Maximum Runtime 
Threshold

The maximum allowed runtime for the chain 
node.

 l Global

Minimum Runtime 
Threshold

The minimum allowed runtime for the chain 
node.

 l Global

SQL Server
The following settings are configurable for SQL Server:

SQL Server
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Miscellaneous

Setting Definition Level Con-
figurable

Auto-
enable SQL 
Server 
Agent 
Tokens

Whether or not to enable SQL Server Agent Tokens on SQL Server 
2005 instances.

Important:  On SQL Server 2005 and above, SQL Server Agent 
tokens are disabled as a security measure. They must be enabled 
to allow SQL Sentry to watch alerts on these servers. Selecting 
True allows SQL Sentry to automatically enable these tokens when 
an alert is watched on a 2005 and above server.

Additional Information:  For more information about SQL Server 
Agent Tokens, see SQL Server Books Online.

 l Global
 l Site/Group
 l Target

Auto-
recycle 
large SQL 
Server 
Agent Logs

Whether or not to automatically recycle large agent log files in SQL 
Server 2005 or greater.

 l Global
 l Site/Group
 l Target

Collect 
Session 
TempDB 
Usage

Set to True to turn on data collection for TempDB Usage and 
populate the TempDB Session Usage table.

 l Global
 l Site/Group
 l Target

Collect 
TempDB 
Object 
Stats

Set to True to turn on data collection for TempDB Usage and 
populate the TempDB Object Stats charts.

See the Troubleshooting article for more guidance on this setting.

 l Global
 l Site/Group
 l Target

Maximum 
Queue 
Length

This setting specifies the maximum number of jobs that can be 
queued at one time on this server. For more information, see the 
Job Queuing topic.

This setting is used to provide more detail than the basic cleaner 
memory data, but it is higher overhead to collect. Use caution 
when enabling this setting to ensure it doesn't impact 
performance. The default value for this setting is False.
Note:  The default value for this setting is 5.

 l Global
 l Site/Group
 l Target
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Setting Definition Level Con-
figurable

Inherit 
From 
Parent

Specifies whether miscellaneous settings are inherited from the 
parent object.

 l Site/Group
 l Target

Synchronization

Setting Definition Level Con-
figurable

Max User Databases to 
Synchronize (largest first)

The maximum number of databases to 
synchronize, ordered by total size. This includes 
system databases.

 l Global
 l Site/Group
 l Target

Max User Database Files to 
Synchronize (most active & 
largest first)

The maximum number of user database files to 
synchronize (most active & largest first).

 l Global
 l Site/Group
 l Target

Inherit From Parent (Global) Specifies whether synchronization settings are 
inherited from the parent object.

 l Site/Group
 l Target

Maintenance Window

Setting Definition Level Con-
figurable

Maintenance 
Window

The maintenance window for targets. Only Log actions will be 
triggered for Failsafe conditions inside the maintenance 
window. Send, Execute, and other actions will not be triggered.

 l Global
 l Site/Group
 l Target

Inherit From 
Parent 
(Global)

Specifies whether maintenance window settings are inherited 
from the parent object.

 l Site/Group
 l Target
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Blocking SQL

Runtime Thresholds

Setting Definition Level Con-
figurable

Maximum Duration 
Threshold

The maximum allowed duration for the object.  l Global
 l Site/Group
 l Target

Inherit From Parent Specifies whether the duration threshold settings are 
inherited from the parent object.

 l Site/Group
 l Target
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Blocking SQL Source

Runtime Thresholds

Setting Definition Level Con-
figurable

Minimum Block 
Duration

The time required to trigger a block condition.  l Global
 l Site/Group
 l Target

Inherit From 
Parent

Specifies whether the blocking settings are inherited from 
the parent object.

 l Site/Group
 l Target
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Databases Source

General Settings

Setting Definition Level Con-
figurable

Enable Table/ 
Index Data 
Collection

Specifies whether table and index collection is enabled. If 
disabled no index management functions will be performed.

 l Global
 l Site/Group
 l Target

Max Partitions 
to Collect per 
Database

The maximum partitions to collect.  l Global
 l Site/Group
 l Target

Min Index Size 
(MB) to Collect 
Fragmentation 
Data

The minimum size of the index in MB to be considered for 
defrag.

 l Global
 l Site/Group
 l Target

Max Index Size 
(MB) to Collect 
Fragmentation 
Data

The maximum size of the index in MB to be considered for 
defrag.

 l Global
 l Site/Group
 l Target
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Setting Definition Level Con-
figurable

Collect Buffer 
Data when 
Buffer > 8GB

Collecting detailed buffer information is inherently a low 
overhead process. However, since it takes approximately 1 
second per GB of buffer, on larger buffers the associated 
query can take some time to complete, which may cause it to 
appear in Top SQL and or generate associated alerts. It is 
generally safe to enable this setting, since SQL Sentry ensures 
that the total time spent per day collecting buffer data will be 
roughly the same regardless of buffer size, and that collection 
only occurs when the buffer has changed.

 l Global
 l Site/Group
 l Target

Inherit From 
Parent

Specifies whether the general database source settings are 
inherited from the parent object.

 l Site/Group
 l Target

Deadlocks Source

Synchronization

Setting Definition Level Con-
figurable

History Filter The filter used for history synchronization. Only events that 
meet the filter will be written to the database.

 l Global
 l Site/Group
 l Target
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Setting Definition Level Con-
figurable

Inherit From 
Parent (Global)

Specifies whether the maximum row count settings are 
inherited from the parent object.

 l Site/Group
 l Target

Collection Settings

Setting Definition Level Con-
figurable

Collect Deadlock 
Events

Specifies whether the deadlock statement collection is 
enabled.

 l Global
 l Site/Group
 l Target

Inherit From Parent 
(Global)

Specifies whether the deadlock settings are inherited 
from the parent object.

 l Site/Group
 l Target
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Index Defragmentation

General Defrag Settings

Setting Definition Level Con-
figurable

Primary 
Schedule

The schedule on which index analysis and/or defrag will be 
performed, according to the configured reorg and rebuild 
thresholds.

 l Global
 l Site/Group
 l Target

Operation Type Options for Analyze Only and Analyze & Defrag.

See the Fragmentation Manager article for more details.

 l Global
 l Site/Group
 l Target
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Setting Definition Level Con-
figurable

Reanalyze 
Indexes After 
Defrag

Specifies whether to run the fragmentation analysis after 
defrag.

 l Global
 l Site/Group
 l Target

Fragmentation 
Scan Mode

The scan mode used when scanning for fragmentation.  l Global
 l Site/Group
 l Target

Maximum 
Concurrent 
Operations

The maximum concurrent operations to run on a SQL Server 
Instance.

 l Global
 l Site/Group
 l Target

Delay Between 
Defrag 
Operations

When Maximum Concurrent Operations is set to 1, you can 
specify a delay between defrag operations to prevent 
send/redo queue overload when availability groups or 
mirroring are in use.

 l Global
 l Site/Group
 l Target

Maximum 
Duration

The maximum allowed runtime for the defragmentation 
process.

 l Global
 l Site/Group
 l Target

Partitions 
(Enterprise 
Only)

Which partitions to include for defragmentation.  l Global
 l Site/Group
 l Target

Inherit From 
Parent

Specifies whether the general database settings are inherited 
from the parent object.

 l Site/Group
 l Target

Index Reorg Settings

Setting Definition Level Con-
figurable

Reorg 
Threshold 
%

The maximum fragmentation percentage before an index reorg is 
performed.

Global 
Site/Group 
Target

Reorg 
Schedule

Dedicated schedule on which reorgs only will be performed, 
according to the reorg threshold. Rebuilds will not be performed 
even if the rebuild threshold has been exceeded.

Global 
Site/Group 
Target
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Setting Definition Level Con-
figurable

Inherit 
From 
Parent 
(Global)

Specifies whether the index reorg setting are inherited from the 
parent object.

Site/Group 
Target

Index Rebuild Settings

Setting Definition Level Con-
figurable

Rebuild 
Threshold %

The maximum fragmentation percentage before an index 
rebuild is performed.

 l Global
 l Site/Group
 l Target

Rebuild 
Schedule

Dedicated schedule on which rebuilds only (online or offline) 
will be performed, according to the rebuild threshold.

 l Global
 l Site/Group
 l Target

Offline Rebuild 
Window

If an offline rebuild will be performed as the result of the 
primary schedule, then only start the offline rebuild during 
this window.

 l Global
 l Site/Group
 l Target

Sort in tempdb Specifies whether to use tempdb for sorting.  l Global
 l Site/Group
 l Target

Use Online 
Rebuild 
(Enterprise Only)

Specifies whether to rebuild the index while online (Enterprise 
Only).

 l Global
 l Site/Group
 l Target

MAXDOP 
(Enterprise Only)

The max degree of parallelism to use during the rebuild.  l Global
 l Site/Group
 l Target

Inherit From 
Parent (Global)

Specifies whether the index reorg settings are inherited from 
the parent object.

 l Site/Group
 l Target
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Maintenance Plans Source

General

Setting Definition Level Con-
figurable

Auto-watch New 
Objects

Whether or not new objects will be set to watched when 
they are discovered.

 l Global
 l Site/Group
 l Target

Inherit From Parent 
(Global)

Specifies whether general settings are inherited from the 
parent object.

 l Site/Group
 l Target

Synchronization

Setting Definition Level Con-
figurable

Maximum 
Rows to 
Synchronize

The maximum rows of historical event data to collect from this 
source. This settings is most applicable to the initial loading 
process, since subsequent synchronizations will only include 
new records. Use care when increasing this value – If it is set 
too high database content can result.

 l Global
 l Site/Group
 l Target

Inherit From 
Parent 
(Global)

Specifies whether the maximum row count settings are inherited 
from the parent object.

 l Site/Group
 l Target
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Reporting Services Report

Runtime Thresholds

Setting Definition Level Con-
figurable

Maximum 
Runtime 
Threshold

The maximum allowed duration for the object.  l Global
 l Site/Group
 l Target

Maximum 
Runtime 
Threshold 
Percent

The maximum allowed duration percentage for the object. See the 
warning below.

Note:  The default value is 250. This means that any time a job 
runs for less than 10 (default Minimum Runtime Threshold  
Percent) or longer than 250 percent of its average runtime, a 
notification is sent. If too many messages are being received, 
these settings can be adjusted as needed.

 l Global
 l Site/Group
 l Target

Minimum 
Runtime 
Threshold

The minimum allowed duration for the object.  l Global
 l Site/Group
 l Target

Minimum 
Runtime 
Threshold 
Percent

The minimum allowed duration percentage for the object.

Note:  The default value is 10.

 l Global
 l Site/Group
 l Target
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Setting Definition Level Con-
figurable

Inherit 
From 
Parent 
(Global)

Specifies whether the runtime threshold settings are inherited 
from the parent object.

 l Site/Group
 l Target

Important:  For the Maximum Runtime Threshold Percent setting, in cases where the average 
runtime for a job is less than 30 seconds, a maximum allowed runtime value of two minutes is used 
regardless of the Maximum Runtime Threshold Percent setting value.

If you wish to avoid this, you can do either of the following:

 1. Use the Maximum Runtime Threshold setting rather than Maximum Runtime Threshold 
Percent setting.

 2. Use a Response Ruleset for the SQL Server Agent Job: Runtime Threshold Max condition that 
delays alerting until the jobs have run for a duration the user defines.

 

Explicit time-based thresholds can also be specified. Any time an explicit time-based threshold 
is specified it overrides the percentage-based thresholds for that object. Time-based thresholds 
are usually less valuable at the global level, particularly the Minimum Runtime Threshold that 
doesn't have much value globally. Explicit runtime thresholds tend to be more applicable at the 
actual instance or object level for overriding the global percentage thresholds on a case-by-case 
basis.

Note:  Runtime threshold messages for Reporting Services Reports completing in less than 
two minutes aren't processed until they are complete.
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Reporting Services Reports Source

General

Setting Definition Level Con-
figurable

Auto-watch New 
Objects

Whether or not new objects will be set to watched when 
they are discovered.

 l Global
 l Site/Group
 l Target

Inherit From Parent 
(Global)

Specifies whether general settings are inherited from the 
parent object.

 l Site/Group
 l Target

Synchronization

Setting Definition Level Con-
figurable

Maximum 
Rows to 
Synchronize

The maximum rows of historical event data to collect from this 
source. This settings is most applicable to the initial loading 
process, since subsequent synchronizations will only include 
new records. Use care when increasing this value – If it is set 
too high database content can result.

Note:  The default is 5000.

 l Global
 l Site/Group
 l Target
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Setting Definition Level Con-
figurable

History Filter The filter used for history synchronization. Only events that meet 
the filter will be written to the database.

 l Global
 l Site/Group
 l Target

Inherit From 
Parent 
(Global)

Specifies whether the maximum row count settings are inherited 
from the parent object.

 l Site/Group
 l Target

SQL Agent Alerts Source

General

Setting Definition Level Con-
figurable

Auto-watch New 
Objects

Whether or not new objects will be set to watched when 
they are discovered.

 l Global
 l Site/Group
 l Target

Inherit From Parent 
(Global)

Specifies whether general settings are inherited from the 
parent object.

 l Site/Group
 l Target
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Synchronization

Setting Definition Level Con-
figurable

Maximum 
Rows to 
Synchronize

The maximum rows of historical event data to collect from this 
source. This settings is most applicable to the initial loading 
process, since subsequent synchronizations will only include 
new records. Use care when increasing this value – If it is set 
too high database content can result.

 l Global
 l Site/Group
 l Target

History Filter The filter used for history synchronization. Only events that meet 
the filter will be written to the database.

 l Global
 l Site/Group
 l Target

Inherit From 
Parent

Specifies whether the maximum row count settings are inherited 
from the parent object.

 l Site/Group
 l Target

SQL Server Agent Job
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Runtime Thresholds

Setting Definition Level Con-
figurable

Maximum Duration 
Threshold

The maximum allowed duration for the object.  l Global
 l Site/Group
 l Target

Maximum Duration 
Threshold Percent

The maximum allowed duration percentage for the 
object.

 l Global
 l Site/Group
 l Target

Minimum Duration 
Threshold

The minimum allowed duration for the object.  l Global
 l Site/Group
 l Target

Minimum Duration 
Threshold Percent

The minimum allowed duration percentage for the 
object.

 l Global
 l Site/Group
 l Target

Inherit From Parent 
(Global)

Specifies whether the runtime threshold settings are 
inherited from the parent object.

 l Site/Group
 l Target

Behavior when Queuing Other Jobs

Setting Definition Level Con-
figurable

Queue 
Other For 
Up To

The maximum length of time this job will queue other jobs.  l Global
 l Site/Group
 l Target

Auto-Start 
Threshold

Any job whose next scheduled run time is beyond the specified 
threshold will be started automatically upon leaving the queue. If a 
job’s next scheduled run time is before the threshold it will not 
auto-start.

 l Global
 l Site/Group
 l Target

Inherit 
From 
Parent 
(Global)

Specifies whether the queuing behavior is inherited from the 
parent object.

 l Site/Group
 l Target
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Behavior When This Job is Queued

Setting Definition Level Con-
figurable

Queue 
Type

The behavior when this job is queued.  l Global
 l Site/Group
 l Target

Queue For 
Up To

The maximum length of time this job can be queued.  l Global
 l Site/Group
 l Target

Auto-Start 
Type

Controls the auto-start behavior for the job when it leaves the 
queue. “Use default setting” will cause the queuing job’s “Auto-
Start Threshold” setting to be used.

 l Global
 l Site/Group
 l Target

Inherit 
From 
Parent 
(Global)

Specifies whether the behavior when queued is inherited from the 
parent object.

 l Site/Group
 l Target

SQL Server Agent Jobs Source
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General

Setting Definition Level Con-
figurable

Auto-watch New 
Objects

Whether or not new objects will be set to watched when 
they are discovered.

 l Global
 l Site/Group
 l Target

Missed Run 
Threshold

The length of time that must pass before an object run is 
considered to be missed.

 l Global
 l Site/Group
 l Target

Inherit From Parent 
(Global)

Specifies whether general settings are inherited from the 
parent object. 

 l Site/Group
 l Target

Synchronization

Setting Definition Level Con-
figurable

Maximum 
Rows to 
Synchronize

The maximum rows of historical event data to collect from this 
source. This settings is most applicable to the initial loading 
process, since subsequent synchronizations will only include 
new records. Use care when increasing this value – If it is set 
too high database content can result.

 l Global
 l Site/Group
 l Target

Inherit From 
Parent 
(Global)

Specifies whether the maximum row count settings are inherited 
from the parent object.

 l Site/Group
 l Target
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SQL Server Agent Log Source

General

Setting Definition Level Con-
figurable

Auto-watch New 
Objects

Whether or not new objects will be set to watched when 
they are discovered.

Global Site/Group 
Target

Inherit From Parent 
(Global)

Specifies whether general settings are inherited from the 
parent object.

Site/Group Target

Synchronization

Setting Definition Level Con-
figurable

Maximum 
Rows to 
Synchronize

The maximum rows of historical event data to collect from this 
source. This settings is most applicable to the initial loading 
process, since subsequent synchronizations will only include 
new records. Use care when increasing this value – If it is set 
too high database content can result.

 l Global
 l Site/Group
 l Target
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Setting Definition Level Con-
figurable

History Filter The filter used for history synchronization. Only events that meet 
the filter will be written to the database.

 l Global
 l Site/Group
 l Target

Inherit From 
Parent 
(Global)

Specifies whether the maximum row count settings are inherited 
from the parent object.

 l Site/Group
 l Target

Top SQL

Runtime Thresholds

Setting Definition Level Con-
figurable

Maximum Duration 
Threshold

The maximum allowed duration for the object.  l Global
 l Site/Group
 l Target

Maximum Duration 
Threshold Percent

The maximum allowed duration percentage for the 
object.

 l Global
 l Site/Group
 l Target
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Setting Definition Level Con-
figurable

Minimum Duration 
Threshold

The minimum allowed duration for the object.  l Global
 l Site/Group
 l Target

Minimum Duration 
Threshold Percent

The minimum allowed duration percentage for the 
object.

 l Global
 l Site/Group
 l Target

Inherit From Parent  Specifies whether the duration threshold settings are 
inherited from the parent object.

 l Site/Group
 l Target

Top SQL Source
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Collection Settings

Setting Definition Level Con-
figurable

Minimum 
Duration

The minimum required duration for a statement to be logged.  l Global
 l Site/Group
 l Target

Minimum 
CPU

The minimum required CPU for a statement to be logged.  l Global
 l Site/Group
 l Target

Minimum 
Reads

The minimum required reads for a statement to be logged.  l Global
 l Site/Group
 l Target

Minimum 
Writes

The minimum required writes for a statement to be logged.  l Global
 l Site/Group
 l Target

Collect 
Trace 
Events

Specifies whether trace events are collected.  l Global
 l Site/Group
 l Target

Collect 
Statement 
Events

Specifies whether statement events are collected.

Warning:  On systems with very high transaction volumes that 
also make extensive use of scalar functions, enabling Collect 
Statement Events may cause a negative impact on the 
performance of the monitored target, regardless of the effective 
Top SQL Filter settings or the number of events actually collected. 
For more information, see Improve SQL Sever Scalar UDF 
Performance in SQL Server 2019, and Four Ways to improve 
Scalar function performance in SQL Server.

 l Global
 l Site/Group
 l Target

Running 
Events 
Polling 
Interval

Specifies how often the service checks for running events.  l Global
 l Site/Group
 l Target
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Setting Definition Level Con-
figurable

Collect 
Execution 
Plans

Specifies whether execution plans are collected. Running queries 
will not be captured if this setting is set to false.

 l Global
 l Site/Group
 l Target

Max Plan 
Size to 
Collect 
(MB)

Specifies the max plan size to collect in MB.  l Global
 l Site/Group
 l Target

Collect 
Query Stats

Specifies whether query stats collection is enabled.  l Global
 l Site/Group
 l Target

Query Stats 
Sample 
Interval

Specifies how often to sample query stats.  l Global
 l Site/Group
 l Target

Filter Time 
Span

Specifies the base length of time over which the collection filters 
will be applied to Query Stats. See Filter Factor for more details.

 l Global
 l Site/Group
 l Target

Filter Factor The Filter Factor is calculated by dividing the Query Stats Sample 
Interval by the Filter Time Span. The collection filters such as 
Minimum Duration are multiplied by this value when applied to 
Query Stats collection. For example, using the defaults (Query 
Stats Sample Interval = 60 Seconds, Filter Time Span = 30 
Seconds, Minimum Duration = 5 Seconds) the total cumulative 
duration of all executions of a query over the 60 second sample 
interval must be greater than 10 seconds.

 l Global
 l Site/Group
 l Target

Inherit 
From 
Parent

Specifies whether Top SQL Settings are inherited from the parent 
object.

 l Site/Group
 l Target

AI Query 
Assist 
Enabled

Determines whether AI Query Assist is enabled or disabled. This 
setting must be set to True for AI Query Assist to be enabled. 

 l Global
 l Site/Group
 l Target

SQL Server Analysis Services
The following settings are configurable for SQL Server Analysis services:

Getting Started Guide: SQL Sentry page 255

SQL Sentry Settings Pane



Analysis Services

Miscellaneous

Setting Definition Level Con-
figurable

Collect 
Memory by 
Category 
Data

Memory by Category data provides more detail than the basic 
Cleaner memory data, but is higher overhead to collect. Use 
caution when enabling to ensure it does not impact performance.

 l Global
 l Site/Group
 l Target

Inherit 
From 
Parent

Specifies whether miscellaneous settings are inherited from the 
parent object.

 l Site/Group
 l Target

Maintenance Window

Setting Definition Level Con-
figurable

Maintenance 
Window

The maintenance window for watched instances. Only Log 
actions will be triggered for Failsafe conditions inside the 
maintenance window. Send, Execute, and other actions will not 
be triggered.

 l Global
 l Site/Group
 l Target
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Setting Definition Level Con-
figurable

Inherit From 
Parent 
(Global)

Specifies whether maintenance window settings are inherited 
from the parent object.

 l Site/Group
 l Target

Top Commands

Runtime Thresholds

Setting Definition Level Con-
figurable

Maximum Duration 
Threshold

The maximum allowed duration for the object.  l Global
 l Site/Group
 l Target

Inherit From Parent 
(Global)

Specifies whether the duration threshold settings are 
inherited from the parent object.

 l Site/Group
 l Target
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Top Commands Source

Collection Settings

Setting Definition Level Con-
figurable

Minimum Duration The minimum required duration for a statement to be 
logged.

 l Global
 l Site/Group
 l Target

Collect 
MDX/DAX/DMX/XMLA 
Events

Specifies whether the command collection is 
enabled.

 l Global
 l Site/Group
 l Target

Collect DAX Query Plan 
Events

Specifies whether DAX Query Plan events are 
captured. Note that collecting query plans for 
complex DAX queries can have a negative impact on 
performance and should only be enabled for 
troubleshooting purposes.

 l Global
 l Site/Group
 l Target

Inherit From Parent Specifies whether the SSAS settings are inherited 
from the parent object.

 l Site/Group
 l Target

Tintri
The following settings are configurable for Tintri:
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Tintri VMstore

Collection Settings

Setting Definition Level Configurable

Monitor Performance Controls whether performance monitoring is enabled.  l Global
 l Site/Group
 l Target

Maintenance Window

Setting Definition Level Con-
figurable

Maintenance 
Window

The maintenance window for targets. Only Log actions will be 
triggered for Failsafe conditions inside the maintenance 
window. Send, Execute, and other actions will not be triggered.

 l Global
 l Site/Group
 l Target

VMware
The following settings are configurable for VMware:
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VMware Host

Collection Settings

Setting Definition Level Configurable

Monitor 
Performance

Controls whether performance monitoring is 
enabled.

Global Site/Group 
Target

Maintenance Window

Setting Definition Level Con-
figurable

Maintenance 
Window

The maintenance window for targets. Only Log actions will be 
triggered for Failsafe conditions inside the maintenance window. 
Send, Execute, and other actions will not be triggered.

Global 
Site/Group 
Target

Windows
The following settings are configurable for Windows:
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Windows Computer

Collection Settings

Setting Definition Level Con-
figurable

Monitor Performance Controls whether performance monitoring is enabled.  l Global
 l Site/Group
 l Target

Inherit From Parent 
(Global)

Specifies whether collection settings are inherited from 
the parent object.

 l Site/Group
 l Target

Maintenance Window

Setting Definition Level Con-
figurable

Maintenance 
Window

The maintenance window for targets. Only Log actions will be 
triggered for Failsafe conditions inside the maintenance 
window. Send, Execute, and other actions will not be triggered.

 l Global
 l Site/Group
 l Target
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Setting Definition Level Con-
figurable

Inherit From 
Parent 
(Global)

Specifies whether maintenance window settings are inherited 
from the parent object.

 l Site/Group
 l Target

Process Collection

Setting Definition Level Con-
figurable

Collect 
Processes

Specifies whether process collection is enabled.  l Global
 l Site/Group
 l Target

Uncategorized 
Process Filter

The filter controls which uncategorized processes are 
collected. Categorized or well-known processes are always 
collected. Once a process has passed the filter, it will continue 
to be collected until it completes.

 l Global
 l Site/Group
 l Target

Inherit From 
Parent

Specifies whether process collection settings are inherited 
from the parent object.

 l Site/Group
 l Target
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Windows Event Logs Source

General

Setting Definition Level Con-
figurable

Auto-watch New 
Objects

Whether or not new objects will be set to watched when 
they are discovered.

 l Global
 l Site/Group
 l Target

Inherit From Parent 
(Global)

Specifies whether general settings are inherited from the 
parent object.

 l Site/Group
 l Target
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Synchronization

Setting Definition Level Con-
figurable

Maximum 
Rows to 
Synchronize

The maximum rows of historical event data to collect from this 
source. This setting is most applicable to the initial load 
process, since subsequent synchronizations will only include 
new records. Use care when increasing this value – if it is set 
too high database contention can result.

 l Global
 l Site/Group
 l Target

History Filter The filter used for history synchronization. Only events that meet 
the filter will be written to the database.

 l Global
 l Site/Group
 l Target

Inherit From 
Parent 
(Global)

Specifies whether the maximum row count settings are inherited 
from the parent object.

 l Site/Group
 l Target

Windows Task
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Runtime Thresholds

Setting Definition Level Con-
figurable

Maximum Runtime 
Threshold

The maximum allowed duration for the object.  l Global
 l Site/Group
 l Target

Maximum Runtime 
Threshold Percent

The maximum allowed duration percentage for the 
object.

 l Global
 l Site/Group
 l Target

Minimum Runtime 
Threshold

The minimum allowed duration for the object.  l Global
 l Site/Group
 l Target

Minimum Runtime 
Threshold Percent

The minimum allowed duration percentage for the 
object.

 l Global
 l Site/Group
 l Target

Inherit From Parent 
(Global)

Specifies whether the runtime threshold settings are 
inherited from the parent object.

 l Site/Group
 l Target
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Windows Task Source

General

Setting Definition Level Con-
figurable

Auto-watch New 
Objects

Whether or not new objects will be set to watched when 
they are discovered.

 l Global
 l Site/Group
 l Target

Inherit From Parent 
(Global)

Specifies whether general settings are inherited from the 
parent object.

 l Site/Group
 l Target
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Synchronization

Setting Definition Level Con-
figurable

Maximum 
Rows to 
Synchronize

The maximum rows of historical event data to collect from this 
source. This settings is most applicable to the initial load 
process, since subsequent synchronizations will only include 
new records. Use care when increasing this value – if it is set 
too high database contention can result.

 l Global
 l Site/Group
 l Target

Inherit From 
Parent 
(Global)

Specifies whether the maximum row count settings are inherited 
from the parent object.

 l Site/Group
 l Target

Performance Counter Settings
The Performance Counter settings screen is used to set the minimum and maximum values for the 
counter thresholds of that particular counter. These are used to trigger the Performance Counter: 
Threshold Min and Max conditions if any conditions are enabled for them. This option is only 
available when selecting a specific performance counter from the Navigator pane. The following 
settings are configurable for Performance Counters:

Counter Thresholds

Setting Definition Level Configurable

Maximum Maximum performance counter threshold.  l Global
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Setting Definition Level Configurable

Minimum Minimum performance counter threshold.  l Global

SQL Sentry Client Alerts
The client alert status indicator is in the bottom right hand corner of the SQL Sentry client. When an 
alert status is detected, a pop-up with information about the alert displays. 

You may choose to:

 l Pin the alert
 l Dismiss it 
 l Open the Client Alerts window by selecting the alert text 
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Client alerts are designed to provide actionable information about problems in your monitored 
environment. To open the Client Alerts window, double-click the status indicator in the bottom right 
hand of the screen.

You may disable status alert pop-ups or change the recurrence interval through Tools > User 
Preferences > System Status.

The following colors correspond to the different alert levels:

Alert 
Level Description

Green A green status indicates that there are no alerts.

Yellow A yellow status is the warning level indicator. Warning level alerts are generated when 
there is a problem that limits the full functionality of SQL Sentry. This could include the 
SQL Server agent being offline.
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Alert 
Level Description

Red A red status is the error level indicator. Error level alerts are generated when there is a 
significant problem in your monitored environment, such as when an instance has been 
detected as offline, or if there is a problem synchronizing data.

Important:  To configure notifications for instance status and monitoring service errors, see 
the Failsafe Conditions topics.

Concerning the History Synchronization Failed Alert
History Synchronization Failed: Message: SQL Server Agent has information logging turned 
on. The log will fill quickly in this state. Agent log history synchronization will be paused until 
information logging is turned off.

This error message indicates that information logging is enabled for the SQL Server Agent Log. With 
this level of logging enabled, the agent log quickly grows beyond one megabyte in size. The overhead 
associated with reading the SQL Server Agent Log when it grows to this size can cause performance 
problems. SQL Sentry doesn't synchronize the agent log until information logging is disabled.

Information logging can be turned off by completing the following steps.

 1. From SSMS (SQL Server Management Studio), right-click the Error Logs folder within the SQL 
Server agent group node for the associated server, and then select Configure.
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 2. Uncheck Information, and then select OK to save.

Additional Information:  For more information about SQL agent log synchronization issues, see 
the History Synchronization Failed article.

SQL Sentry Data Grids & Filters

Overview
On the different tabs in SQL Sentry, various types of grids are used to display data. The grids contain 
information applicable to the tab they are on. These grids are customizable and provide the user with 
a variety of organizational methods.

Customize your available grids in SQL Sentry. Add additional columns to the desired grid by right 
clicking the column header and then selecting Column Chooser to open the Column Chooser.
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Group by
Many of the grids found in SQL Sentry can be grouped by column fields. To group grids by column 
fields, drag the column to the title area of the grid. This groups all of the data into the respective 
categories of the column selected. The Group By function can also be used by right-clicking on the 
column header and selecting the option from the menu.

Group the queries by dragging a header into the Group by box.

Hide the Group by box by right clicking the Group by area, and then selecting Hide Group by box from 
the context menu.
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Sorting
The grids that are shown in SQL Sentry can be sorted easily to organize data. Select the column 
header to automatically sort according to the values in that column.  

Selecting the same column again toggles between ascending and descending order for data in that 
field. This can also be done by right clicking the column header and selecting Sort Ascending or Sort 
Descending.

You can also sort rows by ascending or descending order by selecting the arrow icon on the desired 
column header.

Filters
A filter can be used along with different sorting methods to organize data on many of the fields found 
on grids in SQL Sentry. The filters show up on applicable column headers on the top right side of the 
cell when the mouse is hovering over it. Choose the filter by selecting the small filter button, which 
brings up the filter menu options.  
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Filter Editor is also available by right-clicking the desired column header. This feature allows the user 
to specify filter conditions by typing them into the window that opens. 

Exporting Grids
Data grids found in SQL Sentry provide a great deal of information to the user in customizable format. 
Once the columns are organized as desired, the user can export the information in a variety of 
formats. 

To export your data, select File from the client toolbar, and then select Export Data. 
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Give the data a file name, select the desired file type, and then select Save to save your exported data.

Note:  Supported File Types include:

 l CSV Files (*.csv)
 l Microsoft Excel (*.xls)
 l Adobe Acrobat Files (*.pdf)
 l Web Pages (*.htm; *.html)

Copying Queries
Copy query cells, rows, or all data by selecting and right clicking a query, and then selecting the 
desired option from the context menu.
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Additional Context Menu Options
Access the following additional context menu options by right-clicking a column header in any grid:

Context menu 
option Description 

Sort Ascending Sorts the selected column by ascending order.

Sort Descending Sorts the selected column by descending order.

Clear Sorting Clears the sorting options for the selected column.

Clear All Sorting Clears all sorting options for the selected pane.

Group By This 
Column

Groups the displayed information by the selected column.

Show Group By 
Box

Shows the group by box for the selected pane.

Hide Group By 
Box

Hides the Group by Box.

Hide This Column Hides the selected column.

Column Chooser Opens the Column Chooser. The Column Chooser provides additional columns 
to sort information.

Best Fit Expands the information for the selected column.

Best Fit (all 
columns)

Expands the information for all columns.

Filter Editor Opens the filter editor.

Show Find Panel Opens the Find Panel. Use this panel to locate specific text within your selected 
pane.

Show Auto Filter 
Row

Opens the Auto Filter Row. Use the Auto Filter Row to add specific filters within 
your selected pane.

Reset Grid Reset the grid to its default configuration.
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Overview
User Preferences allows you to customize the behavior and appearance of your SQL Sentry client. 
Select User Preferences from the Tools menu to review the User Preferences set in your SQL Sentry 
client. Select Restore Defaults to reset all User Preferences to the default value. After making any 
changes to your User Preferences, select Save to save your changes. 
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Calendar Settings 

Settings Description

Calendar Refresh Interval Sets the refresh rate for the calendar.
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Settings Description

Show Events As Conflicts After Specifies the duration that two or more event instances 
must overlap before being shown as a conflict.

Show Popups For Sets the persistence of pop-up messages on the 
calendar.

Default days for Global and Group views Sets the default number of days to display when 
opening these views.

Persist Calendar Filter Between Views Selects to save the filter settings between views.

Auto-scroll Calendar to Current Time Selects to enable auto-scroll for the calendar after there 
has been no user activity for a period of time.

Maximum rows to return for calendar/list 
views

Limiting this value helps to avoid delays in loading 
views due to a large volume of data.

Show Running and Historical Events in 
Recurring Window if Duration Exceeds

Determines what events appear in the recurring window 
at the top of the calendar.

Default interval when using Jump To 
Instance context menus

Sets the time interval that appears when using Jump 
To Instance.
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Navigator Settings
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Settings Description

Highlight Event Failures 
in Navigator for

Sets the length of time to display failed events in red within the 
Navigator pane. If you enable Until Cleared, failures remain in red until 
they are manually cleared.

Automatically clear open 
failures if a subsequent 
run is successful

If the subsequent run of an object is successful, the node is no longer 
marked as failed in the Navigator pane.

Show bold text for 
failures

Items become bold and red in the event of a failure.

Refresh Failures in 
Navigator Every

Specifies how often the Navigator pane refreshes to show failures.

Show failures for 
Unwatched Objects

Enables this setting to display unwatched objects in red within the 
Navigator pane after failure.

Hide Unwatched 
Instances

Enables this setting to hide unwatched instances in the Navigator pane.

Default Event View Style Selects the default view to show when opening an event calendar.   

Prompt me to select a 
product when left-
clicking to open a node

Determines whether or not to prompt for the product to use when 
opening an instance. When unchecked, the default view for 
device/instance nodes is used.

Default view for 
Target/Instance nodes

Determines which action SQL Sentry takes when you select a target or 
instance node.

Auto-synch Navigator 
with the selected tab

Enables this setting to synch objects selected in the current tab with the 
Navigator pane.

Auto-synch 
Settings/Actions with 
the selected tab

Enables this setting to synch objects selected in the current tab with the 
Settings and Conditions pane.

Single-click opens new 
tabs

Enabling this setting allows the opening of new tabs with a single click.

Persist last "Jump To 
Time" value

Enables this setting, and each time Jump to Time is used the previous 
time selection is highlighted by default.

Show warning when 
Alert watch fails due to 
disabled SQL Agent Alert 
Tokens

If enabled, SQL Sentry warns you if you try to watch an alert on a SQL 
Server 2005 and above instance and don't have Agent Tokens enabled.
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Settings Description

Synchronize SQL Server 
registrations any time a 
registration group is 
expanded

If enabled, SQL Sentry synchronizes registered servers under the SQL 
Servers node any time a registration group is expanded. When not 
checked, Synchronize SQL Server Groups can be used in the Navigator 
pane to do this.

Manually manage 
folders for Reporting 
Services

Allows you to create and manage folders beneath the reporting services 
node.

Default Startup Action Determines the first tab displayed on startup.

Navigator Refresh 
Interval

Determines how often the navigator refreshes.
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Colors Settings

Most of the elements in the Event Calendar view may have their colors customized. Beside each color 
selection is a Pick button. When you select Pick, the color palette displays. Default is used to reset all 
colors to their defaults.
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Graphs Settings

Setting Description

Maximum rows to return for graphs 
on Runtime Stats

Limits the amount of data shown in runtime graphs for 
performance reasons.

Maximum rows to return for 
performance graphs

Limits the amount of data shown in performance graphs 
for performance reasons.

Updates Settings

Setting Description

Automatically check 
for software updates 
on startup

When checked, SQL Sentry automatically checks for updates on startup. It's 
checked by default. An internet connection is required.

Automatically check 
for Custom 
Conditions Pack 
updates

When checked, SQL Sentry automatically checks for an updated custom 
conditions pack when launching the global level conditions list. It's checked 
by default. An internet connection is required.
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System Status Settings

Setting Description

System Status Refresh 
Interval

Controls how often the system status screen refreshes.

Show Successful Tasks for 
up to

Sets the length of time successful tasks display on the System 
Status screen.

Disable Status Pop-ups If enabled, client alert status message pop-ups display.

Client Alert Recurrence 
Interval

Controls the recurrence interval for alert pop-ups.
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Performance Analysis Settings
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Setting Description

Show Options on Quick Trace 
launch

When checked, certain options are available when a quick trace 
launches manually. When unchecked, the last options configured 
are used. Options include duration, rows to collect, etc.

Tab Auto-rotation Frequency When used in conjunction with Window > Auto-rotate 
Performance Analysis, it determines how often the tab changes.

Overview Refresh Interval Configures how often data refreshes.

Default time span for history 
mode

Defines the History Mode dashboard's default time range.

Overview Skin Selects the skin color for the Performance Analysis 
Overview screen.

Warn on Actual Plan Execution If this option is enabled, when the Actual Plan command is 
selected, the user is asked to Confirm Query Execution before the 
plan is collected. You can disable these warnings by unselecting 
this setting.

Default Actual Plan Collection 
Mode

Defines whether live profile data is collected by default when an 
actual plan is retrieved.

Live Profile Data Collection 
Interval

Defines how often live profile data is collected during query 
execution.

Only save history when 
command text or connection 
settings change

If enabled, query plan sessions only generate history entries when 
the command text or connection settings change.

Allow opening multiple 
Performance Analysis 
instances for the same Target 
using the Navigator

If checked, performance analysis tabs are not reused for the same 
target.

Default Link Style Defines how often live profile data is collected during query 
execution.

Default Dashboard Mode Defines the default dashboard mode when opening performance 
analysis for a target.

Prompt to Save Session Upon 
Exit

If checked, a prompt displays upon an exit to save the active tabs 
and panes.
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Getting Started with SQL Sentry Portal

Introduction

What is SQL Sentry Portal?

SQL Sentry Portal is a browser-based option for accessing your SQL Sentry environment data that 
uses your existing SQL Sentry database. It replaces the previous mobile applications and Cloud Sync 
options.

Additional Information:  See the Using SQL Sentry Portal article to familiarize yourself with the 
overall layout.

Note:  Chrome and Edge are the recommended browsers for using SQL Sentry Portal.

Are all target types supported with SQL Sentry Portal?
SQL Sentry Portal currently supports the following target types:

 l SQL Server (including Amazon RDS)
 l Azure SQL Database
 l Windows
 l VMware

How do I install SQL Sentry Portal?
See the SQL Sentry Portal Configuration article. SQL Sentry Portal may be installed through the 
classic SQL Sentry Setup Wizard or through EPI commands, as long as the method you choose 
matches your existing SQL Sentry installation.

How do I open SQL Sentry Portal?
Important:  Feature Based Security is enabled by default for SQL Sentry Portal Versions 
2022.2 and greater. The Windows login(s) used to access your portal environment must be 
associated with a SQL Sentry User or Group to avoid connectivity issues.
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Additional Information:  During a new installation, no roles are assigned to default 
users/groups. You need to assign roles to your users/groups on the SQL Sentry Portal 
Permissions Page using the Feature Access Grid. For more information about Security in SQL 
Sentry Portal, see the Portal Security article. 

Once you've installed SQL Sentry Portal, you can open it by completing the following steps:

 1. Enter your domain for the SQL Sentry Portal in your preferred browser. 

Note:  In this example, the SQL Sentry Portal is bound to localhost, http://localhost/. The 
URL to open SQL Sentry Portal includes the port as well: 9991.

You may have a different port to use with your host name. This information can be viewed 
or changed with the SQL Sentry Portal Configuration Utility. See the SQL Sentry Portal 
Configuration article for details.

 2. Enter your authentication credentials to access the SQL Sentry Portal. Use your 
DOMAIN\Username if needed.

Note:  Accounts logging into the SQL Sentry Portal must have access to the Windows 
Server hosting SQL Sentry Portal.

 3. The browser opens SQL Sentry Portal. See the Using SQL Sentry Portal article for help 
navigating SQL Sentry Portal's features.

 4. Select the User Management button to open the User Management page. The Users tab is 
displayed by default. 

 5. Select the applicable permissions that you want to assign to your user. Repeat this step for all 

Getting Started Guide: SQL Sentry page 289

How do I open SQL Sentry Portal?

security.htm
security.htm
http://localhost/
configuration.htm
configuration.htm


of your SQL Sentry Portal users.

Success:  The permission assigned successfully prompt displays when you've made changes to the 
selected user permission. 

Additional Information:  For more information about Security in SQL Sentry Portal, see the 
Portal Security article.

Which features are available in Portal? 
SQL Sentry Portal does not have feature parity with the SQL Sentry client for SQL Sentry. By offering a 
simpler view, it creates an option that can be more attractive for different stakeholders who don't 
need the depth of information and functionality offered in the client, or as more of an everyday view 
for DBAs who may only need to open the client for more advanced troubleshooting.

Note: Remember, you still have access to all the additional SQL Sentry features through the 
SQL Sentry client.

Which features are available in Portal? 
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Health
The Health Inventory view is the default view when opening SQL Sentry Portal. The Inventory screen is 
separated into the health, and alerts tabs. The Health tab displays the health scores for all targets 
globally within your SQL Sentry environment. Critical, Unhealthy, and At Risk targets are sorted by 
ascending Health Score by default.  Click an individual group, or target to drill down into more granular 
views. 

Additional Information:  For more information about Health Views in the SQL Sentry Portal, see 
the Health Views article.

Performance
The Performance tab displays performance charts for the monitored target type. For example, the 
Performance tab for a SQL Server target displays charts such as Network, CPU, System Memory, SQL 
Server Activity, SQL Server Waits, SQL Server Memory, Disk, and Database I/O.

Additional Information:  The charts that are available in the Performance tab vary based on the 
target type selected. See the SQL Sentry Portal Performance article for more information about 
the Performance tab.

Storage
The Storage view provides details about the disk space and disk activity in your monitored 
environment. The Storage is only available on SQL Sentry Portal and acts as a combined view of the 
Disk Activity and Disk Space tabs in the SQL Sentry Client. 

Additional Information:  For more information about the Storage tab, see the Storage article. 

Always On
The Always On view displays availability group topology information, data transfer graphs between 
primary and secondary replicas, availability databases, and any changes in the state of replicas for 
the selected cluster.

Top SQL
The Top SQL view displays a unified picture of collected SQL statements. It's designed to help you 
quickly identify queries, applications, logins, and more that are causing the most waits, using the most 
resources, taking the most time, and putting the most load on your SQL Server.
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Additional Information:  For more information about Top SQL in the SQL Sentry Portal, see the 
Top SQL article.

Alerts
Alerts displays a list of all the conditions that have evaluated to True. View Alerts globally, or at group 
or target levels.

Additional Information:  For more information about Alerts in the SQL Sentry Portal, see the 
Alerts article.

Blocking
The Blocking view maps the relationships between all blocking and blocked sessions (SPIDs) in a 
blocking chain, allowing you to pinpoint the cause and fix the blocking issue.

Additional Information:  For more information about Blocking in the SQL Sentry Portal, see the 
Blocking article.

Deadlocks
The Deadlocks view provides details about deadlocks within your monitored environment. Use it to 
identify and fix deadlock issues on your monitored servers.

Additional Information:  For more information about Deadlocks in the SQL Sentry Portal, see the 
Deadlocks article.

TempDB
The TempDB view displays a wealth of information about what is using your tempdb database and 
how effectively it is being used. This feature is specific to SQL Sentry Portal and is not available in the 
SQL Sentry client.

Additional Information:  For more information about TempDB in the SQL Sentry Portal, see the 
TempDB article.

Dashboards
The Dashboard view displays the performance charts for monitored targets.

Which features are available in Portal? 
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Additional Information:  For more information about Dashboards in the SQL Sentry Portal, see 
the Custom Charts article. 

Custom Charts
SQL Sentry Portal offers the ability to create dashboards with configurable custom charts. With 
custom charts, you can include the performance metric widgets that you want, and you can have 
custom charts for different targets on the same dashboard. This feature is specific to SQL Sentry 
Portal and is not available in the SQL Sentry client.

Additional Information:  For more information about Custom Charts in the SQL Sentry Portal, 
see the Custom Charts article.

Using SQL Sentry Portal

Overview & Navigation
SQL Sentry Portal is a self-hosted feature for SQL Sentry which has a similar UI experience. See the 
Getting Started with SQL Sentry Portal article for information on accessing it.

Default Home View

When you first log in to SQL Sentry Portal, the home view displays the overall health of the monitored 
environment. 
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Option Description

1. 
Navigation 
bar

Options for navigating between Inventory, Dashboards, and User Management pages. 
A multi-tenant drop-down selector that lets you jump between your tenants. Click the 
vertical ellipsis options menu to see options for a dark/light mode toggle,  
documentation link, SolarWinds support link, feature request link, and the SQL Sentry 
Portal version number. Full details are provided under the Navigation Bar section 
below.

2. Sidebar The Inventory sidebar has areas for  monitored Targets and a search bar filtering 
specific targets. Full details are provided under the Sidebar section below.

3. Health 
Overview

Health Overview is the default view when opening SQL Sentry Portal.

 l Overall Health Score shows a summary of your overall health score for the 
monitored environment in 24 hour or 1 week periods.

 l Environment Score card lets you filter by health score status to quickly identify 
critical and unhealthy monitored targets.

See Health for more information.

4. Alerts A table of the most recent alerts that have been triggered across the monitored 
environment.

See Alerts for more information. 
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Navigation Bar

This is the default view for the navigation bar:

Option Description

1. Inventory The Inventory view is the default screen that displays health and alerts data for 
all of your monitored targets in SQL Sentry Portal. From the Health Overview, you 
can drill down into individual group or target views. 

2. Dashboards Click Dashboards to view, create, and edit all of your existing dashboards, 
custom charts, and templates in SQL Sentry Portal. See Custom Charts for more 
information. 

3. User 
Management 

Click  User Management to manage permissions in SQL Sentry Portal.

4. Platform 
Connect

Click Platform Connect to open Platform Connect configuration options. 
Platform Connect for SQL Sentry Portal integrates SQL Sentry Portal with 
SolarWinds Observability to access SolarWinds Platform Cloud Notification 
Services. See Platform Connect.

5. SQL Sentry 
Tenant drop-
down

If you have a multi-tentant SQL Sentry environment, use the tenant drop-down to 
change the selected tenant.

6. 
Documentation

Click the vertical ellipsis button to open expanded menu options:

 l Click the theme toggle to change the SQL Sentry Portal view between dark 
and light modes.

 l Select Documentation to open the SQL Sentry Portal documentation.
 l Select SolarWinds support to go to support.solarwinds.com.
 l Select Submit a feature request to submit ideas about any issues, features 

you'd like to see, or suggested changes.
 l View the Version number of SQL Sentry Portal for this installation.

Sidebar

The sidebarcontains the following.
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Option Description

1. Targets 
Filtering 
Options

Start typing a target name in the filter to get to a filtered list of targets or a specific 
target. 

Note:  The target filtering option only appears when there are five or more targets.

2. Targets Targets provides a list of all targets in your monitored environment.

Unwatched Servers are displayed in light grey in the target list. Unwatched servers are 
targets that are not currently being monitored by SQL Sentry. See the Unwatched 
Servers section below for more details.

Unwatched Servers

Unwatched servers are not currently being monitored by SQL Sentry. Unwatched servers are greyed 
out in the side navigation menu. Use the SQL Sentry client to watch a target (you may need to 
purchase additional licenses).
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Note:  A banner appears an individual unwatched targets across the SQL Sentry Portal views.

Feature Menu

When you select a target from the sidebar, the target Health view opens by default. From a target view 
like Health, the Navigation Bar toggles to a feature menu.

The following options are available for individual targets:

 1. Health

 2. Performance

Performance Analysis is available in SQL Sentry Portal for VMware targets. 

 3. Storage

 4. Top SQL

 5. Blocking

 6. Deadlocks

 7. TempDB

Distributed Databases

If you are using SQL Sentry Portal for SQL Sentry and have multiple SQL Sentry databases, you can 
configure your portal to display information for all your SQL Sentry databases through a single 
service. See the Distributed Databases article for more information.
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Plan Explorer Navigation

Introduction
The following are the primary features and information about the different tabs found within Plan 
Explorer. Since the graphical plan diagram in SSMS was used as a starting point for the design of 
Plan Explorer, some features are compared with the current capabilities of SSMS to illustrate the 
reasoning behind the feature.

Plan Explorer Menus

File Menu

Command Description

New Creates a new Plan Explorer Session in a new tab. 

Open Opens an existing Execution Plan file (.sqlplan | .xml | .queryanalysis | .pesession), 
deadlock file, or SQL file.

Save Saves the current file.

Save As Saves the current file with a new name/new location.

Save All Saves all files opened in any tabbed sessions.

Recent Files 
>

Displays a list of recently opened files.

Exit Exits the program.

Plan Explorer Navigation
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View Menu

Command Description

Plan History Opens the Plan History pane.

Comments Opens the Comments pane.

Start Page Opens the Start Page pane. 

Plan Layout 
Control

Opens the Layout Editor. Use the Layout Editor to customize the position of the 
various panes.

Tools Menu

Command Description

User Preferences Allows you to edit the user preferences. 

Edit Connection Allows you to edit the server connection. 

Anonymize Plan Allows you to anonymize a .sqlplan. 
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Window Menu

Command Description

Float Allows the selected panel to detach from the main window rather than being 
docked.

Note:  This can also be done by dragging the panel by its titlebar.

Close All 
Documents

Closes all open query plans. 

Reset Window 
Layout

Resets the windows to the default state.

New Horizontal 
Tab Group

Creates a new Horizontal tab group with the selected tab.

New Vertical Tab 
Group

Creates a new Vertical tab group with the selected tab.

Move to Next 
Tab Group

Moves the selected tab group to the next group.

Move to 
Previous Tab 
Group

Moves the selected tab group to the previous group.

1 Plan Opens the desired query plan. 

Windows... Uses the Windows command to manage all your open windows. Uses the 
Activate command to set focus to the selected window.

Plan Explorer Menus
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Help Menu

Command Description

Plan Explorer Help Opens to Plan Explorer in the SQL Sentry User Guide. 

Check for Updates Checks for the newest version of Plan Explorer.

About Views information about Plan Explorer, including build number and 
contact information.

End User License 
Agreement

Opens the www.solarwinds.com/legal/eula article about licensing 
information. 

Toolbar

Button Description

New—Creates a new Plan Explorer Session in a tab.

  Open—Opens an existing Session file, Execution Plan, Deadlock, or SQL file,

  Save—Saves the current file.

Save All—Saves all the currently open files.

  Copy—Copies the selected text to the clipboard. 

  Paste—Pastes the selected text from the clipboard.

Comment selected lines— Makes the selected line(s) a comment.

Uncomment selected lines— Removes the comment tab from the selected line(s).
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Button Description

Edits the current connection information.

Generates an Estimated Plan. (Shortcut Key: CTRL-L)

Generates an Actual Plan. (Shortcut Key: F5 or CTRL-E)
Select the With Live Query Profile option from the drop-down list. A 
usage chart appears that plots CPU, I/O and waits. 

Note:  Disable the Query Execution warning message with User 
Preferences (Tools > User Preferences > Warn on actual execution).

Stops the execution of a query.

Toggles the Plan Diagram tab between the Estimated and Actual 
Plan.

Horizontal Layout—Switches the current tab to a horizontal layout.

Vertical Layout—Switches the current tab to a vertical layout.

Command Text

The Command Text section shows an editable version of the query text for the statement or batch 
being analyzed. Make changes to the query, then see how this impacts the execution plan by 
selecting GetEstimated Plan or GetActual Plan on the toolbar.

When retrieving a plan, you're asked for the server, database, and credentials to connect (unless you 
launched Plan Explorer from within SSMS using our Management Studio Add-In).

Command Text
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To generate the Actual Plan, the query is run against the target server. By design, the actual query 
results aren't returned to the Plan Explorer interface. By default, there's a message box explaining this 
behavior when an Actual Plan is captured.

Note:  Disable the Query Execution warning message with User Preferences (Tools > User 
Preferences > Warn on actual execution).

If query execution fails, a message displays in the Status bar, located at the bottom of the Plan 
Explorer window.
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